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1 Welcome to Diplomat Managed File Transfer 

1.1 What is Diplomat Managed File Transfer? 

The Diplomat® suite of managed file transfer products enables easy creation and management of secure file 
transfers.  You can purchase the edition you need today and seamlessly upgrade to other editions with a simple 
license file replacement. 

Basic Edition Automate secure FTP and PGP encryption in one application. 

> File transfers using any combination of local network, FTP, SFTP (SSH2), and FTPS (TLS) 

> Intuitive transaction set-up with extensive job scheduling options 

> Central, encrypted transaction database to protect passwords and passphrases  

> Import pre-existing public and secret key rings from OpenPGP-compatible tools  

> Create and export PGP keys 

> OpenPGP to encrypt, decrypt, sign, verify, ASCII-armor, and/or compress files 

> Create, import, and export SSH client keys for key authentication with SFTP file transfers 

> Ability to recover from transient file transfer errors without restarting file transfer jobs 

> Back up, merge, and restore of transaction database for fast recovery  

> Automated clean-up of archived data and log files  

> Capture of advanced troubleshooting data 

> Comprehensive tracking of user activity on screen and in log files 

> Multi-threaded, client-server design for flexible deployment and high performance 

Standard 
Edition 

Integrate secure file transfers into business processes.   

Offers all the capabilities of Basic Edition plus: 

> File transfers to and from email, HTTP, HTTPS and SMB servers 

> Email error notifications for immediate follow-up and problem resolution 

> Emergency paging notifications 

> Built-in audit database to track job statistics for improved regulatory compliance 

> Create and schedule standard audit, key, and transaction reports for easy oversight 

> Ability to archive data files and log files to multiple locations 

> Use of Additional Encryption Keys (AEKs) for easy decryption of archived files 

> Diplomat MFT Scripting Agent for initiating Diplomat MFT jobs  

> Monitor folders to trigger file transfer jobs when new files arrive 

> Enhanced specification, selection, and naming of source and destination files 

> Administration of user login identities for easy, secure authentication of multiple concurrent users 

> Access Diplomat components without installing locally using Diplomat MFT Web Launch 

Enterprise 
Edition  

Provide a single point of control for business-critical secure file transfers.  

Offers all the capabilities of Standard Edition plus: 

> Monitor scheduled and live file transfer jobs using Diplomat MFT Job Monitor 

> File transfers using Diplomat Cloud Connector with built-in PGP encryption and checkpoint restart 

> Execute processes before or after a file transfer job, including custom processes, zipping/unzipping files 
and linked transactions 

> Save source, destination and PGP key settings for use in multiple file transfer jobs  

> Identify unused keys, partners and transactions for fast system clean-up 

> Capture job history and user activity data in a SQL audit database for compliance and custom reporting 

> Temporarily suspend file transfers to immediately respond to security breaches 

> On-screen status icons show file transfers as actively scheduled, suspended, or set to allow external 
requests 

> Easily merge new file transfer jobs from test systems onto production systems 

> Manage job queue settings 

http://www.coviantsoftware.com/diplomat-managed-file-transfer-components.php
http://www.coviantsoftware.com/diplomat-managed-file-transfer-components-job-monitor.php
http://www.coviantsoftware.com/diplomat-managed-file-transfer-components-cloud-connector.php
http://www.coviantsoftware.com/how-to-use-pgp-keys.php
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> Diplomat MFT REST API to initiate, manage and monitor file transfer jobs 

> Connectors for file transfers to and from Amazon S3, Box, Citrix ShareFile, Dropbox, Google Cloud, 
Microsoft Azure and Oracle Cloud public cloud storage 

 

1.2 Typical Customer Scenarios 

Encryption and secure file transfer are technologies that can be used to safeguard files as they are transferred 
outside of a local area network.  It can replace more expensive, traditional approaches to data security, such as 
leased lines or hardcopy tape shipments.  These open technologies are especially popular in industries that face 
the twin challenges of privacy regulations and compression of financial margins – such as healthcare and financial 
services.  
 
Encryption and secure file transfer can be chosen for internal security or forced upon the buyer by the 
requirements of a trading partner.  A few typical customer scenarios include: 

Meet Trading Partner Requirement for OpenPGP  
Key Need: A large trading partner or vendor has made a strategic decision to move to OpenPGP as its 

encryption standard and now requires your company to send and receive encrypted files in this 
format.   

 
Solution: With Diplomat, you can automate file transfer jobs that send or pick up files at specific times 

from specific locations.  No need to remember to encrypt and send files.  Diplomat Managed File 
Transfer Basic Edition is an excellent choice for single trading partner implementations.  It is 
simple to manage with all of the functionality you need to schedule file transfer jobs. 

 

Centralize Secure File Transfer Management 
Key Need: As part of your security policy, you have made a strategic decision to move to OpenPGP as your 

encryption standard and secure FTP for all file transfers with your trading partners.   
 
Solution: With Diplomat MFT Enterprise Edition, you can set up profiles for each of your trading partners 

that include locations of source and destination files, FTP information, encryption and signature 
keys, and special handling information, such as ASCII armoring and canonical text.  In addition, 
Diplomat MFT Enterprise Edition provides real-time job monitoring and the ability to respond 
immediately to security breaches by suspending file transfer jobs by key or by partner.  Plus, it 
simplifies regulatory compliance with an extensive SQL audit database with detailed information 
on every user activity and file transfer job. 

 

Automate File Transfers with Remote Sites 
Key Need: Many businesses need to send files containing sensitive data between a central, corporate hub 

and multiple remote sites, such as branch offices, retail stores, sales offices, or distribution sites.  
As a rule, these remote sites do not have skilled IT personnel on site and the local users typically 
have limited technical skills.   

 
Thus, a file transfer solution that is feasible for a corporate hub falls short of the level of 
simplicity required in a solution for a remote site. 
 

Solution: Diplomat MFT Basic Edition is ideal for automation of file transfers with remote sites.  Basic 
Edition is a full-featured, secure file transfer application with extensive file handling options, 
integrated job scheduling, and excellent remote site security.  Basic Edition does not rely on local 
IT expertise…  

▪ A local user can set up file transfers with a simple Windows application without the need to 
use batch scripts or entering commands at a DOS prompt.   
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▪ Basic Edition can be pre-configured with file transfer jobs before distribution to the remote 
site.  

▪ Basic Edition enables fast problem diagnosis and correction. It automatically generates log 
files with detailed entries and comes with a built-in log file reader with extensive search 
capabilities for use when troubleshooting a failed file transfer.  

▪ Basic Edition automates system management tasks. It automatically retains archive copies of 
all files sent or received. And, it automatically performs housekeeping tasks with no 
intervention by the local user, such as deleting old log and archive files.  
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1.3 Deployment 

Diplomat Managed File Transfer is a Java-based, client-server application that runs on Windows and Linux systems.  
The following diagram shows a typical network configuration for a Diplomat MFT solution:  
 

 

Deployment Overview 
 

The Diplomat MFT Client is a user application that enables the creation and modification of transaction, key, and 
other information.  It captures all transaction information and administrative settings in the Diplomat MFT 
transaction database for use by the Diplomat MFT Service.  The Diplomat MFT Client is located behind the 
corporate firewall in a secure datacenter or elsewhere on the local network. 

The Diplomat MFT Service is the runtime engine that executes transactions stored in the Diplomat MFT transaction 
database. It runs as a service and performs all of the file transfer management activities specified in the Diplomat 
MFT transaction database. The Diplomat MFT Service is located behind the corporate firewall (typically in a secure 
datacenter) and interoperates with FTP servers and other systems that may be in a corporate DMZ.  It creates a log 
file with system messages and archives of transaction files.  
 
Diplomat MFT Service requires that a Java-enabled Web server be installed on the same system.  The Tomcat web 
server from The Apache Software Organization (www.apache.org) is automatically installed during the Diplomat 
MFT Service installation.  On Windows systems, the Tomcat web server is set up as a Windows service, called 
Diplomat MFT 64, and on Linux systems as a daemon, called diplomatServer. 
 
Each trading partner or other group that receives encrypted files from or sends encrypted files to Diplomat MFT 
must have an OpenPGP application at their site.  However, an installation of Diplomat MFT is not required at the 
trading partner site.   

http://www.apache.org/
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2 Installing Diplomat Managed File Transfer 
 
Diplomat Managed File Transfer is supported on various platforms as follows: 
 

 Diplomat MFT 
Service 

Diplomat MFT 
Client 

Windows 71, 8 and 10 ( 64-bit) X X 

Windows Server 2008 R21 (64-bit) X X 

Windows Server 20121 (64-bit) X X 

Windows Server 20161 (64-bit) X X 

Windows Server 20191 (64-bit) X X 

Red Hat Linux (64-bit) X  

Linux (64-bit) with glibc 2.5 or higher X  

 
 
Refer to Appendix A: Configuration Requirements for exact operating system releases supported.  
 
NOTE:  If you have data in a Diplomat MFT trial copy that you would like to retain, use File > Backup to create a 
backup file.  Install a Diplomat MFT paid copy and use File > Restore to import the data from your trial copy.  Then, 
uninstall the Diplomat MFT trial copy.  

2.1 Windows Installation 

Diplomat Managed File Transfer uses a single Windows installation module to install all Diplomat MFT 
components.  NOTE: The Diplomat MFT Service must be installed and started before the Diplomat MFT Client can 
be used.  
 
In addition to performing an initial installation, you can: 
 

Modify  ▪ Add  one or more components to an existing installation 

▪ Uninstall a component from an existing installation 

Repair  ▪ Reinstall all previously installed components  

Remove  ▪ Uninstall all Diplomat MFT components 

 
 
 
1 When running Windows 7, Windows Server 2008 or follow-on products, the Diplomat MFT Service cannot run as a local 
system account.  A login account with Administrator privileges must be specified. 
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2.1.1 Initial Install 

Use the following instructions only if you are installing Diplomat MFT components on a system on which no 
Diplomat MFT components are currently installed. 
 
1. Log on to the system where Diplomat MFT components are to be installed.  You must use a Windows account 

with administrator privileges if you are installing the Diplomat MFT Service. 
 
2. Go to www.coviantsoftware.com and log on using the username and password supplied by Coviant Software 

Support.  Navigate to http://www.coviantsoftware.com/support-portal.php.  Download and unzip the 
DiplomatSetup file for the correct edition of Diplomat Managed File Transfer.   
 

 
3. Double-click on the filename to start the installation.  You can change an installation setting by selecting Back 

until you reach the previous window where the change is needed. Otherwise, select Next to continue to the 
next step. You can select Cancel at any time to stop the installation.  
 

 
 

http://www.coviantsoftware.com/
http://www.coviantsoftware.com/support-portal.php
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4. Scroll through the license agreement and review the terms and conditions. If you agree with the terms, select 
‘I accept the terms of the license agreement’ and Next to continue.  You may print a copy of the license 
agreement for your records using the Print button. 

 
 

 
 
5. Choose the type of setup you would like.  Select Complete to install the default Diplomat MFT components in 

the default location (C:\Program Files\Coviant Software\Diplomat-j).  Select Custom to choose Diplomat MFT 
components to install or to change the installation location. 
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6. If you chose Custom, select Next to accept the default location (C:\Program Files\Coviant Software\Diplomat-
j) or Change… to identify a new installation directory. 
 
NOTE:  The default location for a Diplomat MFT trial copy is C:\Program Files\Coviant Software\Diplomat-trial. 

 

 
 
7. If you selected Custom, check which components to install on the next screen.   

 

 
 



DIPLOMAT BASIC EDITION USER GUIDE v8.2 

 

Proprietary and Confidential 
DO NOT DISTRIBUTE 

Copyright ©2005-2019 Coviant Software Corporation.  All Rights Reserved. 
9 

8. If you chose to reinstall the Diplomat MFT Service, you have the option to associate a Windows user account 
with the Diplomat MFT Service during the installation. If you choose not to provide a user account at this time, 
you must specify a login account with the required privileges for the Diplomat Service after installation.  See 
http://www.coviantsoftware.com/setting-windows-login.php for detailed instructions on how to update the 
Diplomat Service. 
 

 
 

9. If you choose to provide a user account,  follow the instructions below: 

▪ Enter the logon information for the Windows account to be used with the Diplomat MFT Service or select 
New User Information… to create a new Windows account.   

 

 

http://www.coviantsoftware.com/setting-windows-login.php
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▪ Using Browse… to select a DOMAIN and Username ensures that DOMAIN/Username is entered correctly.  
NOTE:  A Windows logon account with Administrator privileges is REQUIRED when running on Windows 7, 
Windows Server 2008 or follow-on products. 

 
 

▪ If you are creating a new user, ensure that ’Administrator’ is selected in the Group field to ensure that 
the new Windows account has administrator privileges. 

 
 

▪ If you plan to use mapped drives or UNC paths when setting up transactions and access to the source and 
destination directories is restricted, you must assign the logon account for the Diplomat MFT Service the 
required privileges.  See Appendix B: Windows Diplomat MFT Service for more information. 
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10. Select a maximum memory limit for the Diplomat MFT service.  For values greater than 8 GB, choose ‘Other’.   
 NOTE: Maximum memory should typically be set to no more than 50% of installed memory. 
 
 

 
 

11. Select Install on the next screen to start the installation.  
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12.  When the installation is complete, you must: 
 

 
 

▪ Copy the Diplomat MFT license file (i.e., *.lic) that you received from Coviant Software Support to 
C:\ProgramData\Coviant Software\Diplomat-j.t 
 
NOTE:  The default password for all new licenses is ‘diplomat’.  You are prompted to reset this password 
when you start the Diplomat MFT Client. 
 
NOTE:  The ProgramData directory is a system folder and may be hidden by the operating system.  To 
display the ProgramData directory and sub-directories, open Windows Explorer.  Select ‘Organize > Folder 
and search options’ from the top menu. Select the View tab.  Select ‘Show hidden files, folders, and 
drives’. 
 
NOTE:  The default location for Diplomat MFT trial licenses is …\Diplomat-trial. 
 

▪ Before attempting to start the Diplomat MFT Client, start the Windows service named Diplomat MFT 64, 
which starts and stops the Tomcat web server.  The Diplomat MFT Service is set to start automatically on 
reboot.  You can manually start the service through Services under the Windows Control Panel.  

▪ If needed, you can confirm that the Diplomat MFT Service is working properly by opening a browser 
window and navigating to https://localhost:8080 which should display the Tomcat home page.  If the 
Tomcat server is not running, see Appendix B: Windows Diplomat MFT Service. 

NOTE:  The server port is set to 8080 by default.  If port 8080 is already in use, contact Coviant Software 
Support for instructions on how to change the server port number. 
 
NOTE:  You may receive a message from your browser indicating a problem with the web site’s security, 
Select Continue in order to access the Tomcat home page. 

 

https://localhost:8080/


DIPLOMAT BASIC EDITION USER GUIDE v8.2 

 

Proprietary and Confidential 
DO NOT DISTRIBUTE 

Copyright ©2005-2019 Coviant Software Corporation.  All Rights Reserved. 
13 

13. The final screen indicates that you have successfully completed the component install or uninstall. 
 

 
 

14. If firewall software is running on the Diplomat MFT site, check to ensure that it is configured to allow Internet 
access for the Diplomat MFT processes.  The service name is Diplomat MFT 64 and the process name is 
tomcat*_64.exe.  These files are located in the …\Diplomat-j\tomcatWebserver\bin directory or your 
corresponding install directory.  The process name that the Diplomat MFT Client uses to access the Internet is 
javaw.exe, which is located in the …\Diplomat-j\jre\bin or your corresponding install directory. 

 
15. A new directory structure is created during the installation of the Diplomat MFT Service.  If you selected the 

default installation location, this directory structure is located under C:\Program Files\Coviant 
Software\Diplomat-j.  These directories contain the Diplomat MFT Service. Diplomat MFT data files are located 
either under the install directory or under C:\ProgramData\Coviant Software\Diplomat-j for Windows systems 
that enforce the User Access Control model.  Changes to any of these files can affect the performance of 
Diplomat.  We strongly recommend that you set privileges on these directories to limit access to only 
necessary applications, such as backup.   
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2.1.2 Modify  

Use the following instructions only if you are adding or removing one or more Diplomat MFT components on a 
system on which one or more Diplomat MFT components are already installed.   

 
1. Log on to the system where Diplomat MFT components are to be added or removed.  You must use a 

Windows account with administrator privileges if you are adding the Diplomat MFT Service. 
 
2. Open the Diplomat MFT Client. Create a backup file under File > Backup in the top menu bar. 

 
3. Set each transaction to ‘Do Not Run’ in the Job Schedule panel in the Transaction screen.  Exit from the 

Diplomat MFT Client. 
 
4. If you are removing the Diplomat MFT Service, you must stop the Diplomat MFT Service.  You can access the 

Diplomat MFT Service through Services under the Windows Control Panel. 
 
NOTE:  When you stop the Diplomat MFT Service manually, it may not stop immediately.  The system waits 
until all currently queued or running jobs are complete before stopping the service.  You will be reminded to 
confirm that the Diplomat MFT Service is not running. 
 

5. Go to www.coviantsoftware.com and log on using the username and password supplied by Coviant Software 
Support.  Navigate to http://www.coviantsoftware.com/support-portal.php.  Download and unzip the 
DiplomatSetup file for the correct edition of Diplomat Managed File Transfer.   

 
6. Double-click on the filename to start the installation.  You can change an installation setting by selecting Back 

until you reach the previous window where the change is needed. Otherwise, select Next to continue to the 
next step. You can select Cancel at any time to stop the installation.  

 
7. Select Modify.   
 

 
 

http://www.coviantsoftware.com/
http://www.coviantsoftware.com/support-portal.php
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8. To ADD a component, check all of the currently installed components AND the new component. The new 
component will be installed in the directory in which each original component was installed.  The default 
directory is C:\Program Files\Coviant Software\Diplomat-j. To REMOVE a component, uncheck the component 
to be removed AND check the components to be retained.   
 
NOTE:  The default location for Diplomat MFT trial licenses is …\Diplomat-trial. 

 
CAUTION: DO NOT leave a component that is already installed unchecked. If you do, the unchecked 
component will be uninstalled. 

 

 
 

9. If you chose to reinstall the Diplomat MFT Service, you have the option to associate a Windows user account 
with the Diplomat MFT Service during the installation. If you choose not to provide a user account at this time, 
you must specify a login account with the required privileges for the Diplomat Service after installation.  See 
http://www.coviantsoftware.com/setting-windows-login.php for detailed instructions on how to update the 
Diplomat Service. 
 

 
 

http://www.coviantsoftware.com/setting-windows-login.php
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10. If you choose to provide a user account,  follow the instructions below: 

▪ Enter the logon information for the Windows account to be used with the Diplomat MFT Service or select 
New User Information… to create a new Windows account.  Using Browse… to select a DOMAIN and 
Username ensures that DOMAIN/Username is entered correctly.  NOTE:  A Windows logon account with 
Administrator privileges is REQUIRED when running on Windows 7, Windows Server 2008 or follow-on 
products. 

 
 

▪ If you are creating a new user, ensure that ‘Administrator’ is selected in the Group field to ensure that 
the new Windows account has administrator privileges. 

 
 

▪ If you plan to use mapped drives or UNC paths when setting up transactions and access to the source and 
destination directories is restricted, you must assign the Windows logon account for the Diplomat MFT 
Service the required privileges.  See Appendix B: Windows Diplomat MFT Service for more information. 
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11. Select a maximum memory limit for the Diplomat MFT service.  For values greater than 8 GB, choose ‘Other’.  
NOTE: Maximum memory should typically be set to no more than 50% of installed memory. 

 
 

 
 

12. Select Install on the next screen to start the installation.  When the installation is complete, you must: 
 

 
 

If you installed the Diplomat MFT Service, copy the Diplomat license file (i.e., *.lic) that you received from 
Coviant Software Support to C:\ProgramData\Coviant Software\Diplomat-j . 
 
NOTE:  The default password for all new licenses is ‘diplomat’.  You will be prompted to reset this 
password when you start the Diplomat MFT Client. 
 
NOTE:  The ProgramData directory is a system folder and may be hidden by the operating system.  To 
display the ProgramData directory and sub-directories, open Windows Explorer.  Select Organize > Folder 
and search options from the top menu. Select the View tab.  Select Show hidden files, folders, and drives. 
 
NOTE:  The default location for Diplomat MFT trial licenses is …\Diplomat-trial. 
 

▪ Before attempting to start the Diplomat MFT Client, start the Windows service named Diplomat MFT 64, 
which starts and stops the Tomcat web server.  The Diplomat MFT Service is set to start automatically on 
reboot.  You can manually start the service through Services under the Windows Control Panel.  
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▪ If needed, you can confirm that the Diplomat MFT Service is working properly by opening a browser 
window and navigating to https://localhost:8080 which should display the Tomcat home page.  If the 
Tomcat server is not running, see Appendix B: Windows Diplomat MFT Service. 

 
NOTE:  The server port is set to 8080 by default.  If port 8080 is already in use, contact Coviant Software 
Support for instructions on how to change the server port number. 
 
NOTE:  You may receive a message from your browser indicating a problem with the web site’s security, 
Select Continue in order to access the Tomcat home page. 

 
13. The final screen indicates that you have successfully completed the component install or uninstall. 
 

 
 

14. If firewall software is running on the Diplomat MFT site, check to ensure that it is configured to allow Internet 
access for the Diplomat MFT processes.  The service name is Diplomat MFT 64 and the process name is 
tomcat*_64.exe.  These files are located in the …\Diplomat-j\tomcatWebserver\bin directory or your 
corresponding install directory.  The process name that the Diplomat MFT Client uses to access the Internet is 
javaw.exe, which is located in the …\Diplomat-j\jre\bin or your corresponding install directory. 

 
15. A new directory structure is created during the installation of the Diplomat MFT Service.  If you selected the 

default installation location, this directory structure is located under C:\Program Files\Coviant 
Software\Diplomat-j.  These directories contain the Diplomat MFT Service. Diplomat MFT data files are located 
either under the install directory or under C:\ProgramData\Coviant Software\Diplomat-j for Windows systems 
that enforce the User Access Control model.  Changes to any of these files can affect the performance of 
Diplomat.  We strongly recommend that you set privileges on these directories to limit access to only 
necessary applications, such as backup. 

 
 

https://localhost:8080/
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2.1.3 Repair  

Use the following instructions if you are reinstalling ALL current Diplomat MFT components.  
 
1. Log on to the system where Diplomat MFT components are to be reinstalled.  You must use a Windows 

account with administrator privileges if you are reinstalling the Diplomat MFT Service. 
 

2. Open the Diplomat MFT Client and set each transaction to ‘Do Not Run’ in the Job Schedule panel in the 
Transaction screen.  Exit from the Diplomat MFT Client. 

 
3. If you are repairing the Diplomat MFT Service, you must stop the Diplomat MFT Service.  You can access the 

Diplomat MFT Service through Services under the Windows Control Panel. 

NOTE:  When you stop the Diplomat MFT Service manually, it may not stop immediately.  The system waits 
until all currently queued or running jobs are completed before stopping the service.  During the repair, you 
will be reminded to reconfirm that the Diplomat MFT Service is not running. 

 
4. Go to www.coviantsoftware.com and log on using the username and password supplied by Coviant Software 

Support.  Navigate to http://www.coviantsoftware.com/support-portal.php.  Download and unzip the 
DiplomatSetup file for the correct edition of Diplomat Managed File Transfer.   
 

5. Double-click on the filename to start the installation.  You can change an installation setting by selecting Back 
until you reach the previous window where the change is needed. Otherwise, select Next to continue to the 
next step. You can select Cancel at any time to stop the installation.  

 
6. Select Repair.   

 

 
 

http://www.coviantsoftware.com/
http://www.coviantsoftware.com/support-portal.php
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7. If the Diplomat MFT Service component is installed, choose whether to reinstall it.  
 

 
 

8. If you chose to reinstall the Diplomat MFT Service, you have the option to associate a Windows user account 
with the Diplomat MFT Service during the installation. If you choose not to provide a user account at this time, 
you must specify a login account with the required privileges for the Diplomat Service after installation.  See 
http://www.coviantsoftware.com/setting-windows-login.php for detailed instructions on how to update the 
Diplomat Service. 
 

 
 

http://www.coviantsoftware.com/setting-windows-login.php
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9. If you choose to provide a user account, follow the instructions below: 
 
▪ Enter the logon information for the Windows account to be used with the Diplomat MFT Service or select 

New User Information… to create a new Windows account.  Using Browse… to select a DOMAIN and 
Username ensures that DOMAIN/Username is entered correctly.  NOTE:  A Windows logon account with 
Administrator privileges is REQUIRED when running on Windows 7, Windows Server 2008 or follow-on 
products. 
 

 

▪ If you are creating a new user, ensure that ‘Administrator’ is selected in the Group field to ensure that 
the new Windows account has administrator privileges. 

 
 

▪ If you plan to use mapped drives or UNC paths when setting up transactions and access to the source and 
destination directories is restricted, you must assign the Windows logon account for the Diplomat MFT 
Service the required privileges.  See Appendix B: Windows Diplomat MFT Service for more information. 

▪ Before attempting to start the Diplomat MFT Client, start the Windows service named Diplomat MFT 64, 
which starts and stops the Tomcat web server.  The Diplomat MFT Service is set to start automatically on 
reboot.  You can manually start the service through Services under the Windows Control Panel.  
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10. Select a maximum memory limit for the Diplomat MFT service.  For values greater than 8 GB, choose ‘Other’.  
NOTE: Maximum memory should typically be set to no more than 50% of installed memory. 

 
 

 
 

11. Select Install on the next screen to start the installation.  When the installation is complete, you must: 
 

 

 

 

▪ If needed, you can confirm that the Diplomat MFT Service is working properly by opening a browser 
window and navigating to https://localhost:8080 which should display the Tomcat home page.  If the 
Tomcat server is not running, see Appendix B: Windows Diplomat MFT Service. 

 
NOTE:  The server port is set to 8080 by default.  If port 8080 is already in use, contact Coviant Software 
Support for instructions on how to change the server port number. 
 
NOTE:  You may receive a message from your browser indicating a problem with the web site’s security, 
Select Continue in order to access the Tomcat home page. 

 

https://localhost:8080/
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12. The final screen indicates that you have successfully completed the repair. 
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2.1.4 Remove  

Use the following instructions only if you are uninstalling ALL Diplomat MFT components.  If you want to uninstall 
one or more components (e.g., the Diplomat MFT Client or the Diplomat MFT Service), review the previous section 
on Modify Installation.  
 
1. Log on to the system where Diplomat MFT components are to be removed.  You must use a Windows account 

with administrator privileges if you are removing the Diplomat MFT Service. 
 

2. Open the Diplomat MFT Client and set each transaction to ‘Do Not Run’ in the Job Schedule panel in the 
Transaction screen.   Exit from the Diplomat MFT Client. 

 
3. If you are uninstalling the Diplomat MFT Service, you must stop the Diplomat MFT Service.  You can access the 

Diplomat MFT Service through Services under the Windows Control Panel. 
 

NOTE:  When you stop the Diplomat MFT Service manually, it may not stop immediately.  The system waits 
until all currently queued or running jobs are completed before stopping the service.  During the uninstall, you 
will be reminded to reconfirm that the Diplomat MFT Service is not running. 

 
4. Select Windows Start button and then Control Panel > Add/Remove Programs > Diplomat Managed File 

Transfer. 
 
5. Select Remove.  
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6. Confirm that you want to completely remove all Diplomat MFT components. 
 

 
 
7. If prompted, confirm that the Diplomat MFT Service is stopped. 

 

 
 
8. The final screen indicates that you have successfully uninstalled Diplomat. 

 
When you uninstall the Diplomat MFT Service, the Diplomat MFT Service may be deleted automatically or 
marked for deletion and set to disabled.  Check the status of the Diplomat MFT Service through Services under 
the Windows Control Panel.  If the Startup Type is set to disabled, you must reboot your system to complete 
the uninstall. 
 
NOTE:  If you are planning to reinstall the Diplomat MFT Service on the same system, you must complete the 
deletion of the service by rebooting before attempting the reinstall. 
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2.1.5 Version Upgrade  

Use the following instructions only if you are upgrading all Diplomat MFT components to a new version. 
 

1. Log on to the system where Diplomat MFT components are to be upgraded.  You must use a Windows account 
with administrator privileges if you are reinstalling the Diplomat MFT Service. 
 

2. Open the Diplomat MFT Client and set each transaction to ‘Do Not Run’ in the Job Schedule panel in the 
Transaction screen.  Exit from the Diplomat MFT Client. 

 
3. If you are upgrading the Diplomat MFT Service, you must stop the current Diplomat MFT Service.  You can 

access the Diplomat MFT Service through Services under the Windows Control Panel. 
 
NOTE:  When you stop the Diplomat MFT Service manually, it may not stop immediately.  The system waits 
until all currently queued or running jobs are completed before stopping the service.  During the uninstall, you 
will be reminded to reconfirm that the Diplomat MFT Service is not running. 

 
4. Go to www.coviantsoftware.com and log on using the username and password supplied by Coviant Software 

Support.  Navigate to http://www.coviantsoftware.com/support-portal.php.  Download and unzip the 
DiplomatSetup file for the correct edition of Diplomat Managed File Transfer.   

 
5. Double-click on the filename to start the upgrade.  You can change an upgrade setting by selecting Back until 

you reach the previous window where the change is needed. Otherwise, select Next to continue to the next 
step. You can select Cancel at any time to stop the upgrade.  
 

 
 

http://www.coviantsoftware.com/
http://www.coviantsoftware.com/support-portal.php


DIPLOMAT BASIC EDITION USER GUIDE v8.2 

 

Proprietary and Confidential 
DO NOT DISTRIBUTE 

Copyright ©2005-2019 Coviant Software Corporation.  All Rights Reserved. 
27 

6. Scroll through the license agreement and review the terms and conditions. If you agree with the terms, select 
‘I accept the terms of the license agreement’ and Next to continue.  You may print a copy of the license 
agreement for your records using the Print button. 
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7. If you are upgrading the Diplomat MFT Service, when the upgrade is complete, you must: 
 

 
 

▪ Start the Windows service named Diplomat MFT 64, which starts and stops the Tomcat web server, 
before attempting to start the Diplomat MFT Client.  The Diplomat MFT Service is set to start 
automatically on reboot.  You can manually start the service through Services under the Windows Control 
Panel.  
 
NOTE:  When possible, the Diplomat MFT Service Windows logon account is retained after the upgrade.  

 
▪ Confirm that the Tomcat web server is working properly.  Open a browser window and navigate to the 

secure page https://locatlhost:8080/. You should see the Tomcat home page.  If the Tomcat server is not 
running, see Appendix B: Windows Diplomat MFT Service. 

 
NOTE:  The server port is set to 8080 by default.  If port 8080 is already in use, contact Coviant Software 
Support for instructions on how to change the server port number. 
 
NOTE:  You may receive a message from your browser indicating a problem with the web site’s security, 
Select Continue in order to access the Tomcat home page. 

 
8. The final screen indicates that you have successfully completed the upgrade. 
 

 

https://locatlhost:8080/
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2.2 Linux Installation 

The Linux installation of Diplomat Managed File Transfer supports installation of the Diplomat MFT Service. The 
Diplomat MFT Client is supported only on Windows systems.  

2.2.1 Diplomat MFT Service Initial Install 

1. On the system where the Diplomat MFT Service is being installed, create an operating system account with 
user name ‘diplomat’.  Log on with user name ‘diplomat’.  Create directory /opt/coviant/diplomat-j to be used 
for installation and maintenance of the Diplomat MFT Service.   

 
NOTE:  If you use UNC paths or mounted drives when setting up transactions and access to those paths or 
drives is restricted, the ‘diplomat’ account must have the required access privileges and you must set up the 
diplomatServer daemon to run as the ‘diplomat’ account.   

 
2. Go to www.coviantsoftware.com and log on using the username and password supplied by Coviant Software 

Support.  Navigate to http://www.coviantsoftware.com/support-portal.php.  Download diplomatServer.tar.gz 
for the correct edition of Diplomat Managed File Transfer.   

 
3. Unzip diplomatServer.tar.gz in /opt/coviant/diplomat-j or corresponding directory for your installation to 

install the Diplomat MFT Service software, a Java Runtime Environment (JRE), and the Tomcat web server. 
 
4. Review the license agreement in the file named Coviant Software Clickwrap License Agreement.pdf in 

/opt/coviant/diplomat-j/docs or corresponding directory for your installation.  If you DO NOT agree with the 
license terms, DO NOT continue the installation.  Continuing the installation indicates that you have accepted 
the license terms. You may want to print a copy of the license agreement for your records. 

 
5. To set the diplomatServer daemon for the Tomcat web server to start automatically on system reboot, log on 

as ‘root’.  Execute the setup script at /opt/coviant/diplomat-j/setup or corresponding directory for your 
installation.  This script copies the diplomatServer daemon into the /etc/rc.d/init.d directory, which starts the 
diplomatServer daemon on system startup.  

 
NOTE:  If you use UNC paths or mounted drives when setting up transactions and access to those paths or 
drives is restricted, the ‘diplomat’ account must have the required access privileges and you must set up the 
diplomatServer daemon to run as the ‘diplomat’ account.   

 
You can use the following commands to check the status of or change the diplomatServer daemon: 
  

Command Action 

chkconfig --list Display status of daemons, including diplomatServer 

chkconfig diplomatServer on Configure the diplomatServer daemon to start automatically on reboot  

chkconfig diplomatServer off Disable automatic start of diplomatServer daemon on reboot 

chkconfig --del diplomatServer Permanently delete diplomatServer daemon 

service diplomatServer start Manually start the diplomatServer daemon 

service diplomatServer stop Manually stop the diplomatServer daemon 

service diplomatServer status Check status of the diplomatServer daemon 

 
  

http://www.coviantsoftware.com/
http://www.coviantsoftware.com/support-portal.php
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6. Copy the Diplomat MFT license file, named xxx.lic, that you received from Coviant Software to 
/opt/coviant/diplomat-j or the corresponding directory for your installation.  Rename the xxx.lic file to 
diplomat.lic using all lowercase characters. 

 
NOTE:  The default password for all licenses is ‘diplomat’.  You should reset this password using the Diplomat 
MFT Client immediately after you install a new license. 

 
NOTE:  If you have not received a license file, you can rename the temporary diplomat.templic file in 
/opt/coviant/diplomat-j/startup or the corresponding directory for your installation to diplomat.lic and 
continue the installation.  This license is a preview license only and transaction scheduling is not enabled.  You 
must contact Coviant Software Support to receive a copy of your permanent license. 

   
7. To start the diplomatServer daemon, reboot the Linux system or use the ‘service diplomatServer start’ 

command. 
 
8. To confirm that the diplomatServer daemon is operating correctly, open a web browser and navigate to the 

secure page https://localhost:8080/.  You should see the Tomcat home page.   
 

If you do not see the Tomcat home page, log on as ‘root’ or other account with ‘root’ privileges.   
 
Check whether the diplomatServer daemon was successfully created using the ‘chkconfig --list’ command. If 
you do not see the diplomatServer daemon in the list of daemons, repeat the setup for the diplomatServer 
daemon.  
 
If the diplomatServer daemon does appear in the list, check the status of the diplomatServer daemon using 
the ‘service diplomatServer status’ command.  If the diplomatServer daemon is not running, restart the 
daemon using the ‘service diplomatServer start’ command.   
 
NOTE:  The server port is set to 8080 by default.  If port 8080 is already in use, contact Coviant Software 
Support for instructions on how to change the server port number. 

 
9. Check that the Diplomat MFT Service is functioning by starting the Diplomat MFT Client on a Windows system.  

Connect to the Diplomat MFT Service using the IP address or domain name of the Linux system and the port 
number ‘8080’.  The default username is ‘Administrator’ and the default password is ‘diplomat’ for all licenses.  
You should reset this password immediately after you install a new license. 

 

 
 

https://localhost:8080/
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NOTE:  The Diplomat MFT Client must be the same version as the Diplomat MFT Service.  If the Diplomat MFT 
Service and Client are not the same version, you will receive a message similar to the following one: 
 

 
 
 
10. Check to ensure that all firewall software is configured to allow the diplomatServer daemon access to the 

Internet.   
 
11. A new directory structure is created during the installation of the Diplomat MFT Service.  If you selected the 

default installation location, this directory structure is located under /opt/coviant/diplomat-j or the 
corresponding directory for your installation. These directories contain the Diplomat MFT Service and various 
Diplomat MFT databases.  Changes to any of these files can affect the performance of Diplomat.  We strongly 
recommend that you set privileges on these directories to limit access to only necessary applications, such as 
backup.  
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2.2.2 Diplomat MFT Service Version Upgrade 

1. Exit from the Diplomat MFT Client. 
 
2. On the system where the Diplomat MFT Service is being updated, log on as ‘root’ or other account with ‘root’ 

privileges.  Stop the diplomatServer daemon by using the ‘service diplomatServer stop’ command. 
 
NOTE: When you stop the diplomatServer daemon manually, it may not stop immediately.  The system waits 
until all currently running jobs are completed before stopping the daemon.   
 

3. On the system where the Diplomat MFT Service is being updated, log on with user name ‘diplomat’.   
 
4. Go to www.coviantsoftware.com and log on using the username and password supplied by Coviant Software 

Support.  Navigate to http://www.coviantsoftware.com/support-portal.php.  Download diplomatServer.tar.gz 
for the correct edition of Diplomat Managed File Transfer.   

 
5. Unzip diplomatServer.tar.gz in /opt/coviant/diplomat-j or a corresponding directory for your installation, 

which installs the Diplomat MFT Service software, a Java Runtime Environment (JRE), and the Tomcat web 
server. 

 
6. Review the license agreement in the file named Coviant Software Clickwrap License Agreement.pdf in the 

/opt/coviant/diplomat-j/docs directory or the corresponding directory for your installation.  If you DO NOT 
agree with the license terms, DO NOT continue the installation.  Continuing the installation indicates that you 
have accepted the license terms. You may want to print a copy of the license agreement for your records. 

 
7. Log on as ‘root’ or other account with ‘root’ privileges.  To restart the diplomatServer daemon, reboot the 

Linux system or use the ‘service diplomatServer start’ command. 
 
8. To confirm that the diplomatServer daemon is operating correctly, open a web browser and navigate to the 

secure page https://localhost:8080/.  You should see the Tomcat home page.  
 

If you do not see the Tomcat home page, log on as ‘root’ or other account with ‘root’ privileges.   
 
Check whether the diplomatServer daemon was successfully created using the ‘chkconfig --list’ command. If 
you do not see the diplomatServer daemon in the list of daemons, repeat the setup for the diplomatServer 
daemon.  
 
If the diplomatServer daemon does appear in the list, check the status of the daemon using the ‘service 
diplomatServer status’ command.  If the diplomatServer daemon is not running, restart the daemon using the 
‘service diplomatServer start’ command.   
 
NOTE:  The server port is set to 8080 by default.  If port 8080 is already in use, contact Coviant Software 
Support for instructions on how to change the server port number. 

 

http://www.coviantsoftware.com/
http://www.coviantsoftware.com/support-portal.php
https://localhost:8080/
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9. Check that the Diplomat MFT Service is functioning by starting the Diplomat MFT Client on a Windows system.  
Connect to the Diplomat MFT Service using the IP address or domain name of the Linux system and the port 
number ‘8080’.  T The default username is ‘Administrator’ and the default password is ‘diplomat’ for all 
licenses.  You should reset this password immediately after you install a new license. 

 

 
 
NOTE:  The Diplomat MFT Client must be the same version as the Diplomat MFT Service.  If the Diplomat MFT 
Service and Client are not the same version, you will receive a message similar to the following: 
 

 
 

2.2.3 Diplomat MFT Service Remove 

 
1. Exit from the Diplomat MFT Client. 
 
2. Log on as ‘root’ or other account with ‘root’ privileges.   
 
3. Stop the diplomatServer daemon by using the ‘service diplomatServer stop’ command. 

 
NOTE: When you stop the diplomatServer daemon manually, it may not stop immediately.  The system waits 
until all currently queued or running jobs are completed before stopping the daemon. 

 
4. Execute the uninstall script at /opt/coviant/diplomat-j/uninstall or the corresponding directory for your 

installation to remove the startup script for the diplomatServer daemon. 
 

NOTE:  If you want to permanently uninstall Diplomat MFT Service, including the Diplomat MFT transaction 
database and other Diplomat MFT files, you can delete the /opt/coviant/diplomat-j directory and remove the 
‘diplomat’ user account. 
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3 Basics 

3.1 User Interface Overview 

Diplomat Managed File Transfer has a simple, intuitive user interface that combines a menu bar for overall 
functions that initiate pop-up dialog boxes; a navigation tree for accessing specific transactions and/or keys; and, 
an active window for editing and viewing keys and transactions.  

 

 

Menu Bar allows access to a variety of functions via sub-menus and pop-up dialog boxes: 

▪ File – Control license management, passwords, backup and restore, view log files, other administrative 
functions, and exit. 

▪ Keys – Import, create, export, search/move, delete, and recover OpenPGP, SSH keys, and SSL server 
certificates. 

▪ Transactions – Create, save, delete, and search/move transactions. 
 

Active Window on the right-hand side of the main screen displays the active key or transaction that is being 
viewed or edited.  Some data is displayed in panels that can be maximized for editing and then minimized to save 
screen space. 
 
Navigation Tree on the left-hand side of the main screen displays folders, sub-folders, and objects in a tree format 
for easy navigation.  The navigation tree also: 

▪ Displays root folder name, which is the name of the server where the Diplomat MFT Service is installed and 
the Diplomat version number.  On rollover, the domain and username set as the Diplomat MFT Service login is 
displayed. If no login is set, then a generic login, such as NT AUTHORITY/SYSTEM is shown on rollover. 

▪ Displays keys that are available for use in defining transactions.  

▪ Highlights the name of the active transaction or key that is currently displayed in the active window for 
viewing or editing.  

▪ Bolds the name of any transactions and keys that have changes pending before being saved. 

Menu Bar 

Navigation 
Tree Active 

Window 

Menu Item 

Folder 

Max/Min 
Button 

Data Panel 

Object 

Sub-folder 

Diplomat Basic Edition Client  
Main Screen 

Data Field 
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▪ Allows functions, such as Export, Save, Save As, Reset, Validate, View Log, Run Now, Delete or Search/Move by 
right-clicking transactions or keys.    
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3.2 Database Overview 

Diplomat Managed File Transfer Basic Edition retains data in the Diplomat MFT transaction Database, which is an 
embedded SQL database which contains all data used to create and schedule jobs, including keys, transaction, and 
configuration data.   

3.3 Diplomat MFT Security Model 

Diplomat MFT ensures the security of your data at all times.   

▪ Before files are transferred, use OpenPGP keys to encrypt and sign the files. 

▪ During file transfer, choose either SFTP (SSH2) or FTPS (TLS) to protect both login data and data in transit.  

▪ After files are transferred, use OpenPGP keys to decrypt and verify files. 

In addition, Diplomat MFT works behind the scenes to improve your overall security.  Diplomat: 

▪ Provides additional login protection for Diplomat MFT administrators by requiring a unique password for 
sensitive activities, such as license updates, password updates, and database restores. 

▪ Protects the ability to access and change transaction information with a password-protected login to the 
Diplomat MFT Client. 

▪ Tracks all user activity, such as changes to the Diplomat MFT transaction database, by the User ID provided by 
the operating system where the Diplomat MFT Client is running.  Data on each user activity is captured in the 
Diplomat MFT log files. 

▪ Displays on every screen the last date that the data displayed was updated and the User ID that performed the 
update. 

▪ Automatically encrypts all sensitive data in the Diplomat MFT transaction and configuration databases, 
including the passphrases or passwords associated with OpenPGP or SSH key pairs and FTP servers.  Sensitive 
information is never written to disk in plaintext (i.e., unencrypted) format.   

▪ Uses a secure connection (TLS) for all communications between the Diplomat MFT Client and the Diplomat 
MFT Service. 

▪ Executes transactions using the Diplomat MFT Service or the diplomatServer daemon – which does not require 
that the Diplomat MFT Client be running.  

▪ Only requires the entry of passphrases to manage tasks related to key pairs, such as export, modify, delete, or 
recover.  Passphrases do not need to be known by users setting up file transfer jobs. 

3.4 Security Best Practices 

You can improve the security of your Diplomat MFT implementation by following a few security practices: 

▪ Install and run both Diplomat MFT Service and Diplomat MFT Client behind a firewall.  

▪ Limit the number of OpenPGP key pairs that you create, so that you can remember the correct passphrase 
associated with each key without writing it down. 

▪ Sign all outbound transactions to ensure that your trading partners know the files have not been tampered 
with and that they went sent by you.   

▪ Verify all inbound transactions to ensure that you know the source of the encrypted file. 

▪ Change the password used to access the Diplomat MFT Client on a regular basis. 

▪ Create multiple encryption sub-keys covering different time periods when you create new key pairs.  Your 
trading partners use your same public key to encrypt, but the encryption sub-key changes on a regular basis – 
making your transactions more secure.   
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4 Logging On 
 

 
 
When the Diplomat MFT Client starts, you are prompted to provide information so the Diplomat MFT Client can 
access the Diplomat MFT Service.   
 
NOTE:  The Diplomat MFT Service supports only ONE concurrent client log-in.  
 
Diplomat MFT Client sessions are terminated after a 30 minute period of inactivity. When the session limit is 
reached, the Diplomat MFT Client is automatically logged out and the number of active Diplomat MFT Client logins 
on the Diplomat MFT Service is decremented to 0.  The terminated Diplomat MFT Client remains open but can no 
longer communicate with the Diplomat MFT Service until the password for the session has been re-entered. 
 

 
 
 The Diplomat MFT Client must be the same version as the Diplomat MFT Service.  If the Diplomat MFT Service and 
Client are not the same version, you will receive a message similar to the following one: 
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NOTE:  Diplomat MFT requires different license types for trial and paid copies.  If your license type is not valid with 
this copy, the following error message is displayed.  You must either uninstall all Diplomat Managed File Transfer 
components and install the correct copy or obtain the correct type of license.   
 

 
 
NOTE:  If a Diplomat MFT Client connection is already being used, the Username and Domain/User IDs of the 
connected user is displayed and you are prompted whether or not to terminate one or more existing connections.  
If you terminate an existing connection, the terminated Diplomat MFT Client remains open but can no longer 
communicate with the Diplomat MFT Service. 
 

 
 

4.1 Server Name 

Server Name is the network address of the system running the Diplomat MFT Service or the diplomatServer 
daemon.  If the Diplomat MFT Client and the Diplomat MFT Service are installed on the same system, the server 
name can be ‘localhost’.  If the Diplomat MFT Service is located on a different system than the Diplomat MFT 
Client, the server name is the network IP address or domain name of the system running the Diplomat MFT 
Service. 

4.2 Server Port 

Server Port is set to 8080 by default.  If you uncheck Use Secure Connection, Server Port automatically resets to 
8443.  If port 8080 or 8443 is already in use, contact Coviant Software Support for instructions on how to change 
the server port number or refer to the Changing Diplomat Services Port Numbers FAQ on changing Diplomat MFT 
Service port numbers. 

4.3 Username and Password 

When the Diplomat MFT Client is initially installed, the default password for the username ‘Administrator’ is set to 
‘diplomat’.  Use the Change Password feature under File > Password to update the password for the current user.  
When a password is updated, the new password must be a minimum of 6 characters and include both alpha and 
non-alpha characters.   
 
NOTE: Passwords are case sensitive.  
 
It is very important to change your password regularly.  Although an uninvited user cannot import, modify, export, 
delete, or recover key pairs without the matching passphrase, anyone who can log on to Diplomat can set up 
transactions using your key pairs.  By default, passwords must be updated at least every 6 months.  
 

http://knowledgebase.coviantsoftware.com/customer/portal/articles/1557024-changing-diplomat-services-port-numbers
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4.4 Secure Connection 

Use Secure Connection (TLS) protects all communication between the Diplomat MFT Service and the Diplomat MFT 
Client using Transport Layer Security (TLS).  If you uncheck Use Secure Connection, Server Port automatically resets 
to 8443. 
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5 File Menu 

5.1 File Overview 

The File Menu allows you to backup and restore the Diplomat MFT transaction database, manage your Diplomat 
MFT license, view log files, update your log-in password, and exit the Diplomat MFT Client. 

5.2 File Menu Items 

5.2.1 Backup  

This backup feature is not intended to replace regular backups of the Diplomat MFT database as part of your 
overall backup process.   
 

 
 
Backup copies a snapshot of the Diplomat MFT transaction database to a location of your choice.  The backup copy 
of the database contains the key and transaction data as of the time the backup was done.   
 
You can manually backup your Diplomat MFT databases by selecting File > Backup.  
 
Check the "Remove passwords" option to omit all passwords from the backup file.  This is used when sending a 
backup file to the Coviant Support Team for assistance with configuration issues. 
 
For Windows systems, the default backup directory is C:\ProgramData\Coviant Software\Diplomat-j\backup.  For 
Linux systems, the default directory is /opt/coviant/diplomat-j/backup. Use Browse to select a different directory.  
Use Test to determine whether the location is accessible and is read/write enabled for the login identity used by 
the Diplomat MFT Service.  
 
The default backup filenames are in the form ‘DiplomatBackup.version.year + month + day + hour + minutes + 
seconds.dbu’.  For example, a backup created on September 22, 2004 at 1:19:20 p.m. by Diplomat MFT v6.0 would 
be named ‘DiplomatBackup.6.0.20040922.131920.dbu’.  If desired, you can enter a different backup filename.  
 
 NOTE:  All Diplomat MFT backup files have the file extension ‘.dbu’ for easy lookup. 
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5.2.2 Merge  

Use Merge ONLY if you need to ADD or OVERWRITE keys or transactions from a backup copy of the Diplomat MFT 
database to your current set of keys and transactions.  Use Restore to replace an entire database with a backup 
copy.  
 
You can merge your Diplomat MFT database by selecting File > Merge.  All job scheduling will be suspended and 
processing will wait for all currently queued or running jobs finish executing before starting the merge.  
 
NOTE:  Diplomat MFT attempts to write a backup copy of the Diplomat MFT database to the default backup 
directory before initiating a database merge or restore operation.  
 

 
 
Then, you can browse and select the backup file that you would like to merge with your active database.  
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When merging Diplomat MFT databases, you must decide how duplicate items are handled during the merge 
process.  For example, if you have a key with the same name in both databases, you must choose which key would 
you like retained in the database after the merge process is complete.   
 
If you want the items in your active database retained, indicate that duplicate items should not be overwritten 
during the merge.  If you want the items from the Diplomat MFT backup file to be retained, then indicate that 
duplicate items should be overwritten during the merge.  
 

 
 
CAUTION:  Recoverable keys are not considered during a Diplomat MFT database merge.  Recoverable keys are 
OpenPGP or SSH client keys which have been deleted, but are still available for recovery. Recoverable keys in the 
active database remain available for recovery after the merge.  Recoverable keys in the Diplomat MFT backup file 
being merged with the live database are ignored during the merge and do not appear in the active Diplomat MFT 
database after the merge.    
 
To merge a recoverable key from a Diplomat MFT backup file into an active database, you must either: 
 
▪ Restore the Diplomat MFT backup file containing the recoverable key and keep a backup of the active 

database.  Recover the desired key.  Export the key.  Restore the active database.  Import the key into the 
active database. 

 
▪ Restore the Diplomat MFT backup file containing the recoverable key and keep a backup of the active 

database.  Recover the desired key.  Backup the Diplomat MFT database containing the recovered key.  
Restore the active database.  Merge the active database with the newly saved Diplomat MFT backup file. 
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5.2.3 Restore  

Use Restore to replace an entire Diplomat MFT database with a backup copy. After completing a Restore, the 
Diplomat MFT database contains the key and transaction data as of the time the backup was done.  Any changes to 
the database since the backup was done will be lost.  
 
You can restore your Diplomat MFT database by selecting File > Restore.  All job scheduling will be suspended and 
processing will wait for all currently queued or running jobs finish executing before starting the restore.  
  
NOTE:  Diplomat MFT attempts to write a backup copy of the Diplomat MFT database to the default backup 
directory before initiating a database merge or restore operation.  
 

 
 
 Then, you can browse and select the backup of the database that you would like to restore.   
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5.2.4 License 

Diplomat Managed File Transfer is licensed based on the total number of OpenPGP, SSH client keys, and/or SSL 
certificates associated with your License ID.  The number of allowable keys equals the number of keys you 
purchased.  The License screen displays the information contained in your current license file, diplomat.lic.   
 
NOTE:  If no diplomat.lic file was found when the Diplomat MFT Service started, a “Server initialization failed: No 
License” error message is generated when the Diplomat MFT Client attempts to start.  To correct this problem, 
stop the Diplomat MFT Service.  Navigate to the license file directory.  For Windows systems, the default license 
directory is C:\ProgramData\Coviant Software\Diplomat-j.  For Linux systems, the default directory is the 
installation directory, usually opt/coviant/diplomat-j.    Copy a valid license file into the directory.  Rename the 
license file to diplomat.lic and restart the Diplomat MFT Service. 
 
NOTE:  For more information on license file locations on Windows systems, please refer to Windows Systems with 
User Account Control FAQ. 
 

 
 
NOTE:  If the diplomat.lic license file has expired and the Diplomat MFT Client attempts to start, a “License has 
expired” error message is generated.  If you do not have a new license file, contact Coviant Software Support to 
request one.  To install the new license, stop the Diplomat MFT Service.  Navigate to the license file directory.  For 
Windows systems, the default license directory is C:\ProgramData\Coviant Software\Diplomat-j.  For Linux 
systems, the default directory is the installation directory, usually opt/coviant/diplomat-j.   Copy a valid license file 
into the directory.  Delete the existing diplomat.lic file.  Rename the new license file to diplomat.lic and restart the 
Diplomat MFT Service. 
 

 
 

http://knowledgebase.coviantsoftware.com/customer/portal/articles/1557292-configuration-on-windows-systems-with-user-account-control
http://knowledgebase.coviantsoftware.com/customer/portal/articles/1557292-configuration-on-windows-systems-with-user-account-control
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License Type 
License Type is Preview, Trial, or Paid.  Preview licenses do not allow PGP encryption or file transfer job execution.  
Trial licenses are time-limited with full product functionality.  Paid licenses enable full product functionality.  
Preview and trial licenses work with trial installations.  Paid licenses work with paid installations.  

License ID 
License ID, a 16-digit number, is used to track your license and any related maintenance services.  This number 
appears on your invoice, maintenance agreement, and the About Diplomat MFT screen under Help. 

Creation Date 
Date and time license file created. 

Number of Concurrent Client Connections Allowed 
The number of concurrent Diplomat MFT Client logins allowed by the Diplomat MFT license.  NOTE:  Diplomat MFT 
Basic Edition supports only ONE concurrent Diplomat MFT Client log-in.   

Number of Concurrent Job Monitor Connections Allowed 
The number of concurrent job monitor connections allowed by the Diplomat MFT license.  NOTE:  Diplomat MFT 
Job Monitor is available only with Diplomat MFT Enterprise Edition.   

Number of API Connections 
The number of Diplomat MFT API connections allowed is determined by whether you purchased a Diplomat MFT 
API license. NOTE:  Diplomat MFT REST API is available only with Diplomat MFT Standard and Enterprise Editions.   

Number of Cloud Storage Sites Allowed 
Number of cloud storage sits allowed by the Diplomat MFT license. 

Number of Transactions Allowed 
Number of Diplomat transactions allowed by the Diplomat MFT license. 
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Number of Transactions in Use 
The number of transactions in use equals the number of transactions that you have created.  The total number of 
transactions in use equals the number of transactions displayed in the navigation tree. 

Number of Keys Allowed 
Diplomat Managed File Transfer is licensed based on the number of OpenPGP keys you are allowed to use to 
encrypt/decrypt and sign/verify files, SSH client keys used to validate login to an SFTP (SSH2) server, and/or SSL 
certificates to validate login to an FTPS (TLS) server. 
 
NOTE:  You can have up to the number of keys allowed of OpenPGP keys, SSH client keys, and SSL certificates. 
 
The number of keys allowed is equal to the number of additional keys you purchased plus the keys from your 
primary edition license. You must purchase an additional key for each trading partner or an unlimited key license.  
If you purchased an unlimited key license, the value of this field is ‘UNLIMITED’.  

Number of OpenPGP Keys in Use 
The number of OpenPGP keys in use equals the number of OpenPGP keys that you have created or imported into 
Diplomat.  The total number of OpenPGP public keys and key pairs in use equals the number of OpenPGP keys 
displayed in the navigation tree. 

Number of SSH Client Keys in Use 
The number of SSH client keys in use equals the number of SSH client keys that you have created or imported into 
Diplomat.  The number of SSH client keys in use equals the number of SSH client keys displayed in the navigation 
tree. 

Number of SSL Certificates in Use 
The number of SSL certificates in use equals the number of SSL certificates that you have created or imported into 
Diplomat.  The number of SSL certificates in use equals the number of SSL certificates displayed in the navigation 
tree. 

Number of Diplomat Cloud Connector Sites Allowed  
The number of Diplomat Cloud Connector sites allowed is equal to the number of additional Diplomat Cloud 
Connector site licenses you purchased plus the Diplomat Cloud Connector sites from your primary edition license, 
if any.  NOTE:  Diplomat Cloud Connector sites are available only with Diplomat MFT Standard and Enterprise 
Editions.   

Number of Diplomat Cloud Connector Sites in Use  
The number of Diplomat Cloud Connector sites in use equals the number of unique hostname/port combinations 
in all partner profiles and transactions. 

Expires On 
Date your Diplomat MFT license expires.  You will not be able to run the Diplomat MFT Service or the Diplomat 
MFT Client after this date. If you purchased a perpetual license, the value of this field is ‘Never’.  

Activate Button 
The Activate Button is displayed when the directory that contains the current diplomat.lic file also contains a file 
with a .lic file extension with a creation date/time field that is more recent than the current license file.   
 
NOTE:  You can typically check the create date in the file properties to determine this date. 
 
For Windows systems, the default license directory is C:\ProgramData\Coviant Software\Diplomat-j.  For Linux 
systems, the default directory is the installation directory, usually opt/coviant/diplomat-j.   
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NOTE:  The Activate Button is displayed only when the new license file is for the same Diplomat MFT Edition.  If 
you need to update your license to a different Diplomat MFT Edition, follow the directions in the next section. 
 
NOTE:  The Activate Button is displayed when it matches the type of license required by the Diplomat MFT copy 
installed.  For a trial installation, only preview and trial licenses are displayed.  For a paid installation, only paid 
licenses are displayed. 
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5.2.5 License Update 

To update your license, you must place the new license file in the directory where the current license, diplomat.lic, 
is located. For Windows systems, the default license directory is C:\ProgramData\Coviant Software\Diplomat-j.  
For Linux systems, the default directory is /opt/coviant/diplomat-j. 
 
Once the new license file has been copied to the correct directory, you can update your license by restarting the 
Diplomat MFT Client.  You are notified that a new license is available and prompted whether you would like to 
accept it. 

 

  

 

When your license is updated, the current diplomat.lic file is deleted and the new license file is renamed to 
diplomat.lic.  Log into the Diplomat MFT Client using your current password.  You can reset your password using 
the File > Password menu option which displays the Change Diplomat License Password screen. 

 

 
NOTE: The date/time field in the new license must be more recent than the date/time field in the current 
diplomat.lic file.  If the new license file is older than the current license, Diplomat MFT does not prompt you to 
update your license. You can typically check the create date in the file properties to determine this date. 
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5.2.6 Logs 

You can view the content of log files by selecting File > Logs, then choosing the log files that you would like to view.  
If you check more than one log file on the Choose Log Files to View screen, then all selected log files are appended 
into one screen for viewing.  For Windows systems, the default log directory is C:\ProgramData\Coviant 
Software\Diplomat-j\logs.  For Linux systems, the default directory is /opt/coviant/diplomat-j/logs.   
 
 

 

Set Filter 
Set Filter allows you to select and view a sub-set of all log messages.  If you have already set a filter and then select 
Set Filter again, your previous filter settings are displayed.  

 

Minimum Filter Level  
Limits the log messages selected to include only log messages with a particular log level or above.  Debug 
is the default filter level, which shows all messages, except for large messages such as directory listings.   

Search by Phrase 
Allows you to select all log messages containing a specific phrase.  This feature is helpful when you are 
searching for a particular entry unrelated to a particular transaction. 
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Search by Transaction Name 
Allows you to select all log messages related to a particular transaction.  If no transaction is selected, then 
all transactions are displayed, which is the default.  This feature allows you to view all entries associated 
with a particular transaction in chronological order.   
 
NOTE: If you do not filter by Transaction Name, entries from various transactions are likely to be mixed 
together as Diplomat MFT uses a multi-threaded job scheduling process and all log messages are written 
in chronological order.  
 
NOTE:  Only transactions in the current Diplomat MFT transaction database are displayed in the 
transactions drop-down. 

Reset Filter 
Resets the log viewer to the defaults, such that all messages are displayed. 

Refresh 
Re-displays the current log file using the current filter settings and includes any additional messages added to the 
log file since the last refresh. 

Done 
Closes the Diplomat MFT Log Viewer. 
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5.2.7 Sample Log File 

Log entries start with a line that identifies the level of the message (Debug, Informational, Warning, Error, or 
Critical Error) and a timestamp.  The subsequent lines are the message contents.   
 
The log file contains several types of entries: 
 
▪ Entries for user activity that affects the contents of the Diplomat MFT transaction database, such as updating 

transactions, changing a password, or importing a public key from a trading partner.   
▪ Entries for each step in the execution of a file transfer job.  
▪ Summary entry at the end of each job. 
▪ Error messages. 
 
>Informational  November 12, 2007 5:01:38 PM EST 
Transaction "Out 308": Begins execution 
 
>Informational  November 12, 2007 5:01:38 PM EST 
Transaction "Out 308": Outbound job started 
 
>Informational  November 12, 2007 5:01:38 PM EST 
Transaction "Out 308": Directory: C:\Program Files\Coviant Software\Beta Test Files\AsciiBinary\Globalscape\Outbound RT Source 
 304.txt 
 305.txt 
 306.txt 
 307.txt 
 308.txt 
  
>Informational  November 12, 2007 5:01:38 PM EST 
Transaction "Out 308": Source/destination file pair added to processing list: 
308.txt 
308.txt.asc 
 
>Informational  November 12, 2007 5:01:38 PM EST 
Transaction "Out 308": 1 source files found 
 
>Debug  November 12, 2007 5:01:38 PM EST 
Transaction "Out 308": Source filename: 308.txt  Last modified: 20050214.165846 
 
>Debug  November 12, 2007 5:01:38 PM EST 
Transaction "Out 308": Unencrypted file created and locked: C:\Program Files\Coviant Software\Beta Test 
Files\AsciiBinary\Globalscape\Outbound RT Source\308.txt 
 
>Debug  November 12, 2007 5:01:38 PM EST 
Transaction "Out 308": Signed file created: C:\Program Files\Coviant Software\Diplomat-
beta\tomcatWebserver\webapps\diplomat\WEB-INF\temp\sig58783.tmp 
 
>Debug  November 12, 2007 5:01:38 PM EST 
Transaction "Out 308": Encrypted file created for: C:\Program Files\Coviant Software\Diplomat-
beta\tomcatWebserver\webapps\diplomat\WEB-INF\temp\enc58785.tmp 
 
>Debug  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308": Connected to 75.144.141.131:21 
With userID coviant 
 
>Debug  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308": FTP connection verified 
 
>Debug  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308": File type set to ASCII 
 
>Debug  November 12, 2007 5:01:39 PM EST 
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Transaction "Out 308": Successfully stored file 308.txt.asc 
 
>Debug  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308": Primary archiving skipped 
 
>Debug  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308": Unencrypted file closed 
 
>Debug  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308": Encrypted file closed 
 
>Debug  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308": Temp signed file deleted: C:\Program Files\Coviant Software\Diplomat-
beta\tomcatWebserver\webapps\diplomat\WEB-INF\temp\sig58783.tmp 
 
>Debug  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308": Temp encrypted file deleted: C:\Program Files\Coviant Software\Diplomat-
beta\tomcatWebserver\webapps\diplomat\WEB-INF\temp\enc58785.tmp 
 
>Debug  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308": Beginning end-of-job processing 
 
>Debug  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308": FTP session disconnected 
 
>Informational  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308": Transaction terminated successfully 
 
>Informational  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308" Summary: 
 
SUCCESS: Out 308 was successful at November 12, 2007 5:01:39 PM 
 
Outbound transaction 
 
Source files obtained from C:\Program Files\Coviant Software\Beta Test Files\AsciiBinary\Globalscape\Outbound RT Source 
 308.txt  Last modified: 20050214.165846  File size: 44 
 
Encryption key(s): Public_Test_Encrypt 
Encryption key(s) used: Public_Test_Encrypt_sub0 
Signature key: Integrity_Test_Sign 
Signature key used: Integrity_Test_Sign 
 
Destination files FTP'd to 75.144.141.131:21/ 
 308.txt.asc  File size before xfer: 680  File size after xfer: 680 
 
Primary archiving skipped 
 
Additional archiving skipped 
 
No audit record written 
 
>Debug  November 12, 2007 5:01:39 PM EST 
Transaction "Out 308": Job ended 

 
NOTE:  In addition to the Diplomat MFT logs, the Tomcat web server generates a separate log file each time the 
Diplomat MFT Service or the diplomatServer daemon is started.  These logs are located in the 
…\tomcatWebserver\logs directory, which defaults to C:\Program Files\Coviant Software\diplomat-
j\tomcatWebserver\logs for Windows systems or /opt/coviant/diplomat-j/tomcatWebserver/logs for Linux 
installations.  Tomcat log filenames are in the form:  ‘jakarta_service_ year-month-day.log’.  For example, a Tomcat 
log file created on July 15, 2006 would be named ‘jakarta_service_20060715.log’. 
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5.2.8 Password 

 
 
Change Password 

Current Password 
The current password is the password associated with the current Diplomat MFT MFT Client login. 

New Password/Confirm New Password 
You must enter your new password twice to confirm your password change. Once you change the 
password, you must use the new password to log in to the Diplomat MFT Client.  NOTE:  Passwords are 
case sensitive. They must be a minimum of 6 characters and include both alpha and non-alpha 
characters. 

 
NOTE:  When the Diplomat MFT Client is initially installed, the default password for the username 
‘Administrator’ is set to ‘diplomat’. You should reset this password immediately after you install a new 
license. 
 
NOTE:  To retain your current password, change the current password to a new password.  Then, change 
it back to your current password. 
 

Change Update Interval 

Minimum Password Update Frequency 
Minimum password update frequency can be set to 3, 6, or 9 months.  If you do not want to be prompted 
for regular password updates, select None.  
 

NOTE:  To retain your current password, change the current password to a new password.  Then, change it back to 
your current password. 
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5.2.9 Diplomat Status 

 

 

Diplomat MFT Service 
 
The Diplomat MFT Service panel displays information about the currently installed Diplomat MFT Service, including 
service state, start time, the domain and username associated with the Diplomat MFT Service, the maximum 
memory allocated to the Diplomat MFT Service, Diplomat MFT version and build numbers, JRE version,  Tomcat 
version and certificate, session protocol and session cipher,  

System 
 
The System panel shows the host name, IP address, operating system and architecture of the system where the 
Diplomat MFT Service is running. 

5.2.10 Exit 

Exit closes the Diplomat MFT Client.   
 
You are reminded to save any transactions that have changed, but have not been saved, during the session. You 
can click through to unsaved transactions from the Unsaved Changes pop-up. 
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You are also reminded if you have Advanced Troubleshooting turned on for any transactions.  You can click through 
to the transactions from the Troubleshooting On pop-up or check Turn off troubleshooting on all transactions, if 
desired. 
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6 Working with Keys  

6.1 Keys Overview 

OpenPGP and SSH keys are forms of public key encryption technology.  Both OpenPGP and SSH keys are built on 
key pairs.  Only a public key is needed to encrypt data.  Decryption requires a key pair, which includes a private key 
in addition to a public key.  A public key can be freely distributed without fear that someone will “guess” your 
private key, since a key pair cannot be deduced from the associated public key. 
 
When you want to use OpenPGP to protect file transfers, you create an OpenPGP key pair, export the public key to 
a file, and send the public key file to your trading partners or other remote sites – while retaining and protecting 
your key pair.  Each time you send or receive a file, you must specify which key(s) to use to encrypt, decrypt, sign, 
or verify the file. 
 
SSH client keys are only used when you log into an SFTP server.  With SSH client keys, you create an SSH key pair, 
export the public key, and send the SSH client public key file to the SFTP server administrator.  The server 
administrator attaches the public key to the account you use to access the SFTP server. When you log into the SFTP 
server, the SFTP server automatically uses the public key to authenticate your login request.   
 
SSH host keys are used to verify the SFTP server identity before connecting to it.  SSH host keys are imported into 
the Diplomat MFT database and selected when setting up a Diplomat partner profile.  SSH host keys are added and 
deleted from Diplomat MFT using Keys > SSH Host Keys from the top menu bar. 
 
SSL server certificates are also displayed in the navigation tree under Keys.  SSL server certificates are used when 
the FTPS server administrator requires them for file transfer jobs using FTPS as the transport method.  When an 
SSL certificate is required, the FTPS server administrator sends you a server certificate file (usually ending in .crt).  
SSL certificate files are imported into Diplomat MFT from the top menu under Keys > SSL Certificates > Import SSL 
Certificate.   
 

6.2 Keys Navigation Tree 

The navigation tree shows the Key Names of all keys currently in the Diplomat MFT transaction database.  The keys 
are divided into sub-folders for OpenPGP keys, SSH Client Keys, and SSL certificates.  OpenPGP keys can be public 
keys or key pairs.  Key pairs are your company’s private keys.  Public keys are typically keys that you have received 
from trading partners or remote sites.   
 
Select a sub-folder under OpenPGP Keys, SSH Client Keys or SSL Certificates in the navigation tree and right-click to 
create or import keys, add a sub-folder, expand all sub-folders, collapse all sub-folders, rename the folder, delete 
the folder or search/move the folder. 
 
Select a key in the navigation tree and right-click to save changes to the key, reset the key settings to the saved 
values, export the key to a text file, rename the key, delete the key, or move the key to a new sub-folder. 
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6.3 OpenPGP Keys  

OpenPGP is a public key encryption technology. You publish your public key to your trading partners or remote 
sites while retaining and protecting your key pair. Anyone with a copy of your public key can encrypt files using 
your public key, but only you can decrypt the files. 
 
OpenPGP keys are usually kept in files called key rings or keystores, where keys are stored in encrypted form. If 
you lose or delete your key ring, you will be unable to decrypt any files encrypted with the keys that were on the 
ring. 
 
Individual keys can be exported from key rings into single files. For example, you will need to export a key when 
you send it to a trading partner or if you need to use the key with a different OpenPGP application.  Many 
OpenPGP products keep their public keys and their key pairs in separate key rings.  Diplomat MFT keeps all of its 
keys in a single database.  Diplomat MFT can import keys created by other OpenPGP-compliant products and add 
them to its database. 
 
OpenPGP keys can be used to encrypt/decrypt and to sign/verify files.  When you receive a file signed by a private 
OpenPGP key pair, you can determine the authenticity of the file's origin and verify that the file is intact.  Verifying 
the signature on a file provides non-repudiation, which means that it prevents the sender from claiming that he or 
she is not the source of the information. 
 
When a file is signed with a key pair, only the public key that matches the private key in the key pair can be used to 
verify the signature.  When you establish a relationship with a trading partner, they send you their public key. Each 
time they encrypt a file to send to you, they use their private key to sign the file.  When you decrypt the file, you 
determine whether your trading partner encrypted the file by using their public key to verify the signature.  If you 
cannot verify the signature, then you should assume that your trading partner was not the source of the encrypted 
file. 
 
Here is an example of which keys are used to encrypt/sign and decrypt/verify an inbound file from your trading 
partner: 

▪ You create a key pair to be used for encryption and decryption and give your trading partner the public key. 

▪ Your trading partner creates a key pair for signing and verification and gives you the public key. 

▪ Your trading partner encrypts the file with your public key, signs it with their key pair, and sends the 
encrypted/signed file to you.  

▪ You decrypt the file with your key pair and verify their signature with their public key. 
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The keys used by your company to encrypt/sign and decrypt/verify an outbound file to your trading partner work 
in a similar way: 

▪ Your trading partner creates a key pair to be used for encryption and decryption and gives you the public key. 

▪ You create a key pair for signing and verification and give your trading partner your public key. 

▪ You encrypt the file with your trading partner’s public key, sign it with your key pair, and send the 
encrypted/signed file to them.  

▪ Your trading partner decrypts the file with their key pair and verifies your signature with your public key. 

 
 
The OpenPGP protocol defines standard formats for encrypted messages, signatures, and private keys. The 
OpenPGP encryption standard is defined by the OpenPGP Working Group of the Internet Engineering Task Force 
(IETF) Proposed Standard RFC 2440 and RFC 4880, which can be found at http://www.ietf.org/rfc/rfc2440.txt.   
 
For current information on OpenPGP, go to www.pgpi.org – an international PGP Web site that promotes the use 
of PGP worldwide and a resource pool for information on the PGP program and the OpenPGP standard. 
 
The following books provide further technical and historical information on OpenPGP: 

▪ The Official PGP User's Guide by Phil Zimmermann, MIT Press, 1995, ISBN: 0-262-74017-6. 

▪ PGP: Source Code and Internals by Phil Zimmermann, MIT Press, 1995, ISBN: 0-262-24039-4. 

▪ PGP: Pretty Good Privacy by Simson Garfinkel, O'Reilly & Associates, 1994, ISBN: 1-56592-098-8.  

▪ Protect Your Privacy - A Guide for PGP Users by William Stallings. Prentice-Hall, 1994, ISBN: 0-13-185596-4.  

▪ Crypto - How the Code Rebels Beat the Government, Saving Privacy in the Digital Age  
by Steven Levy, Viking Penguin Putnam, 2001, ISBN: 0-670-85950-8. 

▪ Applied Cryptography: Protocols, Algorithms, and Source Code in C by Bruce Schneier, John Wiley & Sons, 
1995, ISBN: 0471117099.  

▪ Handbook of Applied Cryptography by Alfred J. Menezes, Paul C. Van Oorschot, Scott A. Vanstone, CRC Press, 
1996, ISBN: 0849385237. 

  
   

http://www.ietf.org/rfc/rfc2440.txt
http://www.pgpi.org/
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6.3.1 OpenPGP Keys Menu Items  

In Diplomat Managed File Transfer, each OpenPGP public key and key pair has a unique key name, which is 
displayed when you select keys to be used for encryption, decryption, signing, or verification in a transaction.  
These names should be readily understandable.  For example, you might name the public key for Acme Foods – 
‘Acme Foods Public Key’. 
 
Diplomat MFT OpenPGP key management allows you to: 

▪ Create key pairs for signing and encryption. 

▪ Import existing public keys and key pairs created by other OpenPGP-compliant products. 

▪ Export public keys and key pairs. 

▪ Delete and recover keys. 

▪ Search or move keys. 

NOTE:  All key menu items related to OpenPGP key pairs require the entry of the secret passphrase for that key 
pair. 
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6.3.1.1 OpenPGP Key Pairs 

6.3.1.1.1 Create Key Pair 
 

 

OpenPGP key pairs have a master key and one or more sub-key(s) for encryption. Although each key pair may have 
multiple encryption sub-keys, only one encryption sub-key should be valid at any time.  You are prompted to add 
sub-keys when a master key is created.  When you create OpenPGP keys or sub-keys using Diplomat, you must 
provide several pieces of information:   

Key Name 
All key pairs and public keys must have unique Key Names in Diplomat.  Key Names are used only by Diplomat.  You 
should choose a name that makes it easy for you to determine the intended use of the key when setting up 
transactions.  For example, Acme Corporation might use ‘Acme Decryption Key’ to identify the private key from 
which it plans to export and send the public key portion to its trading partners for encrypting files. Key Name field 
length is limited to 64 characters. 

NOTE:  If you attempt to create a key with a Key Name that already exists in the Diplomat MFT database, you have 
the option to replace the existing key with the new key.  If you choose to overwrite the existing key, you cannot 
recover the original key at a later time.  As a precaution, Diplomat MFT attempts to export a copy of the original 
key before it is overwritten.  For Windows systems, the default key directory is C:\ProgramData\Coviant 
Software\Diplomat-j\keys.  For Linux systems, the default directory is /opt/coviant/diplomat-j/keys.  To ensure 
you do not permanently delete a key, export the original key before you attempt to replace it. 

Key Type 
OpenPGP supports two different key types: DH/DSS and RSA. 
 
NOTE: RSA legacy keys use an older algorithm that is no longer used by most OpenPGP products.  Diplomat MFT 
can import and use RSA legacy keys for encryption/decryption and signing/verification, but it does not support RSA 
legacy key creation. 

Bit strength 
Bit strength of a key is related to how difficult the algorithm is to break.  The larger the bit strength of a key, the 
more difficult and time-consuming the code-breaking task would be.  The larger the bit strength of the key, the 
longer it takes to generate and the longer it takes to encrypt, decrypt, sign, or verify a file.  Keys sizes are generally 
1024, 2048, and 4096.  
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NOTE:  DH/DSS keys allow 1024, 2048, and 4096 for encryption sub-keys, but only 1024 for signature sub-keys.  
RSA keys allow 1024, 2048, and 4096 for encryption and signature sub-keys. 

User ID 
Identifies the owner of the key.  A commonly used practice with OpenPGP keys for personal use is to use your 
email address as the User ID.  As most keys in Diplomat MFT are used for corporate transactions, you may want to 
use the corporate and/or division name using the key.  For example, payroll@acmefoods.com might be a good 
User ID that would indicate that the owner of the key pair is the Payroll Department at Acme Foods.  If you send a 
public key to a trading partner, they are likely to use the User ID to determine the owner of the key. 
 
NOTE:  Some OpenPGP products require that User IDs be in the form ‘FirstName LastName 
<username@domain_name.com>‘, such as ‘John Smith <jsmith@acmefoods.com>‘. 

Passphrase 
OpenPGP uses a passphrase to encrypt your private key.  A passphrase should be hard for you to forget and 
difficult for others to guess.  

You must provide the passphrase, when you import, create, modify, delete, or recover a key pair.  Once you have 
created a key pair in Diplomat, the passphrase is stored separately from the key pair in a special encrypted format.  
When you set up a transaction in Diplomat, for security purposes, you do not need to re-enter the passphrase.  

Expiration 

You can set the expiration of the master key such that it never expires, expires in XX days, or expires on a 
particular date. Symmetric Algorithm(s) 
 

 
 
Symmetric Algorithms are used for data encryption. 

Hash Algorithm(s) 

 
 

Hash Algorithms are used for protecting signatures. 

mailto:payroll@acmefoods.com
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6.3.1.1.2 Import Key Pairs  

Keys created by other OpenPGP-compliant products can be imported into the Diplomat MFT database.  Key rings 
from other OpenPGP products cannot be imported directly.  You must export a key into an individual file using the 
OpenPGP tool that created it and then import it into Diplomat.  Select Keys > OpenPGP Key Pairs > Import Key Pair 
from the top menu bar. 

 

 

 
Browse to the location of the key pair to be imported.  For Windows systems, the default key directory is 
C:\ProgramData\Coviant Software\Diplomat-j\keys.  For Linux systems, the default directory is 
/opt/coviant/diplomat-j/keys.   
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Import Checkbox 

Check Import beside each key in the key ring that you would like to import. 
 
NOTE:  Prior to Diplomat MFT v4.0, you were required to indicate if a key to be imported needed to be compatible 
with PGP5.x or PGP 6.x.  Compatibility is now determined automatically and no longer needs to be specified. 

Key ID 
Uniquely identifies a key.  A public key always has the same Key ID as the key pair from which it was created.  Two 
key pairs or two public keys may have the same User ID, but they must have different Key IDs.   
 
NOTE:  If a key pair to be imported has the same Key ID as a key pair in the Diplomat MFT database, the key cannot 
be imported.  The Import checkbox and Diplomat Key Name field will be disabled.  The rollover message and the 
help message provide  a reminder that the Key ID already exists in the Diplomat MFT transaction database. 

User ID(s) 
Text string that helps identify the owner of the key.  Two key pairs may have the same User ID, but they must have 
different Key IDs. 

Diplomat Key Name 
Diplomat Key Names are used only by Diplomat.  All key pairs and public keys must have unique Key Names in 
Diplomat.  The default value shown in the Diplomat Key Name field is the User ID from the OpenPGP key.  
Diplomat Key Name field length is limited to 64 characters. 
 
NOTE:  Since User IDs do not have to be unique in OpenPGP-compliant key rings, you may need to modify the 
default Diplomat Key Name before importing.  You can choose a name that makes it easy to determine the 
intended use of the key when setting up transactions.  For example, you might use ‘Acme Verification Key’ to 
identify the public key from Acme Corporation that you will use to verify signatures on files you receive.  
 
 
NOTE:  Diplomat Key Names are not the same as Key IDs.  Diplomat MFT allows a public key and a key pair to have 
the same Diplomat Key ID, but two public keys may not have the same Key ID.  You cannot import a public key that 
has the same internal Key ID as an existing public key. 
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NOTE:  A public key in Diplomat MFT and the key pair from which it was created share the same Key ID, but cannot 
share the same Diplomat Key Name. 
 
If you attempt to import a key pair with a Diplomat Key Name that already exists in the Diplomat MFT database, 
you have the option to overwrite the existing key pair or to modify the Diplomat Key Name field.  If you choose to 
overwrite the existing key pair from the screen below, the Overwrite Checkbox is checked automatically. 
 
NOTE:  You cannot import a key pair that has the same Diplomat Key Name as an existing public key.   
 

 
 
NOTE:  If you choose to overwrite the existing key, you cannot recover the original key at a later time.  As a 
precaution, Diplomat MFT attempts to export a copy of the original key before it is overwritten.  For Windows 
systems, the default key directory is either C:\Program Files\Coviant Software\Diplomat-j\keys or 
C:\ProgramData\Coviant Software\Diplomat-j\keys.  For Linux systems, the default directory is 
/opt/coviant/diplomat-j/keys.  To ensure you do not permanently delete a key, export the original key before 
you attempt to replace it. 

Imported Key Passphrase 
The Imported Key Passphrase field is only displayed for key pairs.  OpenPGP uses a passphrase to encrypt each key 
pair.  The imported key passphrase is the passphrase for the key you plan to import.   

Overwrite Checkbox 
An Overwrite checkbox is only displayed for keys with a Diplomat Key Name that already exists in the Diplomat 
MFT database.   
 
NOTE:  If you decide not to overwrite the existing key, simply uncheck the Overwrite checkbox before selecting OK.  

Existing Key Passphrase 
The Existing Key Passphrase field is only displayed for key pairs.  OpenPGP uses a passphrase to encrypt each key 
pair.  If you plan to overwrite an existing key in the Diplomat MFT database, you must enter the passphrase for the 
existing key.  
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6.3.1.1.3 Export Key Pair 
 
Key pairs can be exported from Diplomat MFT for use with other OpenPGP-compliant products.  To export a key 
pair, select the key pair you plan to export from the navigation tree.  Then, select Keys > OpenPGP Keys > Export 
Key Pair from the menu bar.   

 

Passphrase 
OpenPGP uses a passphrase to encrypt your private key.  A pop-up dialog box requests the passphrase, when you 
import, create, delete, or recover a key pair.  

On Server 
Displays the name of the system running the Diplomat MFT Service with which the Diplomat MFT Client currently 
has an active session.  

Key File  
Enter the filename you plan to use for the key pair file.  You may enter a path as part of the filename or browse to 
locate the directory to which the key pair will be exported.  For Windows systems, the default key directory is 
C:\ProgramData\Coviant Software\Diplomat-j\keys.  For Linux systems, the default directory is 
/opt/coviant/diplomat-j/keys.   

Save as File Type 

6.3.1.1.4 Select a file type of either ASCII-armored (*.asc) or OpenPGP (.pgp).Save  

Select Keys > OpenPGP Key Pairs > Save from the top menu bar, enter <Ctrl+S>, or right-click the key in the left 
navigation and select Save.   

6.3.1.1.5 Reset  
Select Keys > OpenPGP Key Pairs > Reset from the top menu bar, enter <Ctrl+R>, or right-click the key in the left 
navigation and select Reset. 
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6.3.1.1.6 Delete  

Key pairs can be deleted from the Diplomat MFT database.  To delete a key, select the key you plan to delete from 
the navigation tree.  Then, select Keys > OpenPGP Key Pairs > Delete from the top menu bar, enter <Ctrl+D>, or 
right-click and select Delete.     

NOTE:  OpenPGP uses a passphrase to encrypt your private key.  You must provide the passphrase, when you 
import, create, or recover a key pair.   

 

If you have forgotten the passphrase and need to delete a key pair, you can force the deletion without a valid 
passphrase. 

 

If a transaction in Diplomat MFT references the key you are attempting to delete, Diplomat MFT does not 
immediately delete the key and you receive the message shown below.   

 

It is strongly recommended that you press “Cancel” and manually remove references to the key before proceeding 
with the key deletion. 

Only press “OK” if you are certain that the key and all of the related transactions are no longer needed.  For 
example, you might choose to delete a key and all of its related transactions if you are no longer doing business 
with the trading partner from which you received the key. 

For example, assume you want to delete a private key pair named ‘Private Key 1’.  ‘Private Key 1’ is specified in 
‘Private Partner 1’ as the Sign/Verify key.  If an outbound transaction ‘Out Transaction 1’ uses the ‘Private Partner 
1’ as the source partner profile but the transaction does not require a signature, then ‘Private Key 1’ is not actually 
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used in ‘Out Transaction 1’.  Since ‘Out Transaction 1’ uses ‘Private Partner 1’, if ‘Private Key 1’ is deleted, the ‘Out 
Transaction 1’ will also be deleted. 
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6.3.1.1.7 Recover  

Key pairs can be recovered, if they were deleted by Diplomat.  To recover a key, select Keys > OpenPGP Key Pairs > 
Recover from the top menu bar.   

NOTE:  OpenPGP uses a passphrase to encrypt your private key.  You must provide the passphrase, when you 
import, create, delete, or recover a key pair.  

 

Recover Checkbox 
Check Recover beside each key that you would like to recover. 

Key Type 
Indicates whether the key available for recovery is a public key or a key pair. 

Key ID 
Uniquely identifies a key.  A public key always has the same Key ID as the key pair from which it was created.  Two 
key pairs or two public keys may have the same User ID, but they must have different Key IDs.   
 
NOTE:  If a key to be recovered has the same Key ID as a key in the Diplomat MFT database, the key cannot be 
recovered.  The Recover checkbox and Diplomat Key Name field will be disabled.  The rollover message and the 
help message provide reminders that the Key ID already exists in the Diplomat MFT transaction database. 
 

User ID(s) 
Text string that helps identify the owner of the key.  Two key pairs may have the same User ID, but they must have 
different Key IDs. 

Diplomat Key Name 
Diplomat Key Names are used only by Diplomat MFT.  All key pairs and public keys must have unique Diplomat Key 
Names.   
 
If you attempt to recover a key with a Diplomat Key Name that already exists in the Diplomat MFT database, you 
have the option to overwrite the existing key or to modify the Diplomat Key Name field.   
 
NOTE:  Only one copy of a deleted key is retained.  If you delete a key with the same Diplomat Key Name as a key 
that has already been deleted, only the most recently deleted key is available for recovery.  For example, assume 
you have a key pair named “Test” and you delete it.  The key pair named “Test” is available for recovery.  Then, you 
import a public key named “Test” and delete it.  The original key pair named “Test” is no longer available for 
recovery.  The public key “Test” is available. 
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NOTE:  If you choose to overwrite the existing key, you cannot recover the original key at a later time.  As a 
precaution, Diplomat MFT attempts to export a copy of the original key to the default keys directory before it is 
overwritten.  For Windows systems, the default key directory is C:\ProgramData\Coviant Software\Diplomat-
j\keys.  For Linux systems, the default directory is /opt/coviant/diplomat-j/keys.  To ensure you do not 
permanently delete a key, export the original key before you attempt to replace it. 

Recovered Key Passphrase 
The Recovered Key Passphrase field is only displayed for key pairs. OpenPGP uses a passphrase to encrypt each key 
pair.  The recovered key passphrase is the passphrase for the key you plan to recover.   

Overwrite Checkbox 
An Overwrite checkbox is displayed for keys with a Diplomat Key Name that already exists in the Diplomat MFT 
database.   
 
NOTE:  If you decide not to overwrite the existing key, simply uncheck the Overwrite checkbox before selecting OK.  

Existing Key Passphrase 
The Existing Key Passphrase field is only displayed for key pairs.  OpenPGP uses a passphrase to encrypt each key 
pair.  If you plan to overwrite an existing key in the Diplomat MFT database, you must enter the passphrase for the 
existing key.  
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6.3.1.1.8 Search/Move 

 
 
OpenPGP Key Search/Move is used to locate OpenPGP keys containing specific phrases and keys that are not 
referenced by any partner profile or transaction.  To select a key for editing, highlight the Key ID in the list and 
select OK. To move a key, highlight the Key ID and drag it to the target folder in the navigation tree. 

Search Criteria  
Search Criteria are used to find keys where the search field contains a specific phrase or keys that are not 
referenced by any partner or transaction.  
 
NOTE:  The phrase field is case sensitive.  
 
NOTE:  Leaving the 'containing phrase' field blank displays an unfiltered list of objects. 

The Search Button is used to initiate the search using the criteria in the Search Criteria panel and displays the 
number of keys found. 

Search Results 
Search Results displays all of the keys that match the search criteria. 

Export 
Use the Export button to export search results to a .csv file. 
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6.3.1.2 OpenPGP Public Keys 

6.3.1.2.1 Import Public Keys  

Keys created by other OpenPGP-compliant products can be imported into the Diplomat MFT database.  Key rings 
from other OpenPGP products can be imported directly or you can export a key into an individual file using the 
OpenPGP-compliant tool that created it and then import it into Diplomat.  Select Keys > OpenPGP Public Keys > 
Import Public Keys from the top menu bar. 

 

 
 
Browse to the location of the key or key ring to be imported.  For Windows systems, the default key directory is 
C:\ProgramData\Coviant Software\Diplomat-j\keys.  For Linux systems, the default directory is 
/opt/coviant/diplomat-j/keys.   
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Import Checkbox 

Check Import beside each key in the key ring that you would like to import. 
 
NOTE:  Prior to Diplomat MFT v4.0, you were required to indicate if a key to be imported needed to be compatible 
with PGP5.x or PGP 6.x.  Compatibility is now determined automatically and no longer needs to be specified. 

Key ID 
Uniquely identifies a key.  A public key always has the same Key ID as the key pair from which it was created.  Two 
key pairs or two public keys may have the same User ID, but they must have different Key IDs.   
 
NOTE:  If a public key to be imported has the same Key ID as a public key in the Diplomat MFT database, the key 
cannot be imported.  The Import checkbox and Diplomat Key Name field will be disabled.  The rollover message 
and the help message provide a reminder that the Key ID already exists in the Diplomat MFT transaction database. 

User ID(s) 
Text string that helps identify the owner of the key.  Two key pairs may have the same User ID, but they must have 
different Key IDs. 

Diplomat Key Name 
Diplomat Key Names are used only by Diplomat.  All key pairs and public keys must have unique Key Names in 
Diplomat.  The default value shown in the Diplomat Key Name field is the User ID from the OpenPGP key.  
Diplomat Key Names field length is limited to 64 characters. 
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NOTE:  Since User IDs do not have to be unique in OpenPGP-compliant key rings, you may need to modify the 
default Diplomat Key Name before importing.  You can choose a name that makes it easy to determine the 
intended use of the key when setting up transactions.  For example, you might use ‘Acme Verification Key’ to 
identify the public key from Acme Corporation that you will use to verify signatures on files you receive.  
 
NOTE:  Diplomat Key Names are not the same as Key IDs.  Diplomat MFT allows a public key and a key pair to have 
the same Key ID, but two public keys may not have the same Key ID.  You cannot import a public key that has the 
same internal Key ID as an existing public key in the Diplomat MFT database. 
 
NOTE:  A public key in Diplomat MFT and the key pair from which it was created share the same Key ID, but cannot 
share the same Diplomat Key Name. 
 
If you attempt to import a public key with a Diplomat Key Name that already exists in the Diplomat MFT database, 
you have the option to overwrite the existing public key or to modify the Diplomat Key Name field.  If you choose 
to overwrite the existing public key from the screen below, the Overwrite Checkbox is checked automatically. 
 
NOTE:  You cannot import a public key that has the same Diplomat Key Name as an existing key pair. 
 

 
 
NOTE:  If you choose to overwrite the existing key, you cannot recover the original key at a later time.  As a 
precaution, Diplomat MFT attempts to export a copy of the original key before it is overwritten.  For Windows 
systems, the default key directory is C:\ProgramData\Coviant Software\Diplomat-j\keys.  For Linux systems, the 
default directory is /opt/coviant/diplomat-j/keys.  To ensure you do not permanently delete a key, export the 
original key before you attempt to replace it. 

Overwrite Checkbox 
An Overwrite checkbox is displayed only for keys with a Diplomat Key Name that already exists in the Diplomat 
MFT database.   
 
NOTE:  If you decide not to overwrite the existing key, simply uncheck the Overwrite checkbox before selecting OK.  
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6.3.1.2.2 Export Public Key 
 

 

OpenPGP public keys can be exported from Diplomat MFT for use with other OpenPGP-compliant products.  To 
export a public key, select the key you plan to export on the navigation tree.  You can export a public key directly 
or the public key portion of a key pair.  Then, select Keys > OpenPGP Public Keys > Export Public Key from the top 
menu bar.   

For example, you might have a key pair named Pinnacle Bank Key Pair for your company to be used for 
transactions with your bank. To export the public key from the key pair to send to Pinnacle Bank, select Pinnacle 
Bank Key Pair in the navigation tree.  Then, select Keys > OpenPGP Public Keys > Export Public Key from the top 
menu bar to export the public key from the key pair.  Then, send the public key file to Pinnacle Bank or via email or 
through your web site. 

On Server 
Displays the name of the system running the Diplomat MFT Service with which the Diplomat MFT Client currently 
has an active session. 

Key File 
Enter the filename you plan to use for the public key file.  You may enter a path as part of the filename or browse 
to locate the directory to which the public key will be exported.  For Windows systems, the default key directory is 
C:\ProgramData\Coviant Software\Diplomat-j\keys.  For Linux systems, the default directory is 
/opt/coviant/diplomat-j/keys.   

Save as File Type 
Select a file type of either ASCII-armored (*.asc) or OpenPGP (.pgp).  

6.3.1.2.3 Save  

Select Keys > OpenPGP Public Keys > Save from the top menu bar, enter <Ctrl+S>, or right-click the key in the left 
navigation and select Save.   

6.3.1.2.4 Reset  
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Select Keys > OpenPGP Public Keys > Reset from the top menu bar, enter <Ctrl+R>, or right-click the key in the left 
navigation and select Reset. 
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6.3.1.2.5 Delete  

Public keys and key pairs can be deleted from the Diplomat MFT database.  To delete a key, select the key you plan 
to delete from the navigation tree.  Then, select Keys > OpenPGP Public Keys > Delete from the top menu bar, 
enter <Ctrl+D>, or right-click and select Delete.    

If a partner profile or transaction in Diplomat MFT references the key you are attempting to delete, Diplomat MFT 
does not immediately delete the key and you receive the message shown below.   

 

It is strongly recommended that you press ‘Cancel’ and manually remove references to the key before proceeding 
with the key deletion. 

Only press ‘OK’ if you are certain that the key and all of the related partners and transactions are no longer 
needed.  For example, you might choose to delete a key and all of its related partners and transactions if you are 
no longer doing business with the trading partner from which you received the key. 

NOTE:  A key specified in a partner profile may or may not be used when the partner profile is selected for a 
transaction.  If you delete a key that is specified in a partner profile, any transaction using that partner profile will 
be deleted – even if the key is not used explicitly in the transaction.   

For example, assume you want to delete a private key pair named ‘Private Key 1’.  ‘Private Key 1’ is specified in 
‘Private Partner 1’ as the Sign/Verify key.  If an outbound transaction ‘Out Transaction 1’ uses the ‘Private Partner 
1’ as the source partner profile but the transaction does not require a signature, then ‘Private Key 1’ is not actually 
used in ‘Out Transaction 1’.  Since ‘Out Transaction 1’ uses ‘Private Partner 1’, if ‘Private Key 1’ is deleted, the ‘Out 
Transaction 1’ will also be deleted. 
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6.3.1.2.6 Recover  

Public keys can be recovered, if they were deleted by Diplomat.  To recover a public key, select Keys > OpenPGP 
Public Keys > Recover from the top menu bar.   

 

Recover Checkbox 
Check Recover beside each key that you would like to recover. 

Key Type 
Indicates whether the key available for recovery is a public key or a key pair. 

Key ID 
Uniquely identifies a key.  A public key always has the same Key ID as the key pair from which it was created.  Two 
key pairs or two public keys may have the same User ID, but they must have different Key IDs.   
 
NOTE:  If a key to be recovered has the same Key ID as a key in the Diplomat MFT database, the key cannot be 
recovered.  The Recover checkbox and Diplomat Key Name field will be disabled.  The rollover message and the 
help message provide a reminder that the Key ID already exists in the Diplomat MFT transaction database. 

User ID(s) 
Text string that helps identify the owner of the key.  Two key pairs may have the same User ID, but they must have 
different Key IDs. 

Diplomat Key Name 
Diplomat Key Names are used only by Diplomat.  All key pairs and public keys must have unique Diplomat Key 
Names.   
 
If you attempt to recover a key with a Diplomat Key Name that already exists in the Diplomat MFT database, you 
have the option to overwrite the existing key or to modify the Diplomat Key Name field.   
 
NOTE:  Only one copy of a deleted key is retained.  If you delete a key with the same Diplomat Key Name as a key 
that has already been deleted, only the most recently deleted key is available for recovery.  For example, assume 
you have a key pair named ‘Test’ and you delete it.  The key pair named ‘Test’ is available for recovery.  Then, you 
import a public key named ‘Test’ and delete it.  The original key pair named ‘Test’ is no longer available for 
recovery.  The public key ‘Test’ is available. 
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NOTE:  If you choose to overwrite the existing key, you cannot recover the original key at a later time.  As a 
precaution, Diplomat MFT attempts to export a copy of the original key to the default keys directory before it is 
overwritten.  For Windows systems, the default key directory is C:\ProgramData\Coviant Software\Diplomat-
j\keys.  For Linux systems, the default directory is /opt/coviant/diplomat-j/keys.  To ensure you do not 
permanently delete a key, export the original key before you attempt to replace it. 

Recovered Key Passphrase 
The Recovered Key Passphrase field is only displayed for key pairs. OpenPGP uses a passphrase to encrypt each key 
pair.  The recovered key passphrase is the passphrase for the key you plan to recover.   

Overwrite Checkbox 
An Overwrite checkbox is displayed for keys with a Diplomat Key Name that already exists in the Diplomat MFT 
database.   
 
NOTE:  If you decide not to overwrite the existing key, simply uncheck the Overwrite checkbox before selecting OK.  

Existing Key Passphrase 
The Existing Key Passphrase field is only displayed for key pairs.  OpenPGP uses a passphrase to encrypt each key 
pair.  If you plan to overwrite an existing key in the Diplomat MFT database, you must enter the passphrase for the 
existing key.  
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6.3.1.2.7 Search/Move 

 
 
OpenPGP Key Search/Move is used to locate OpenPGP keys containing specific phrases and keys that are not 
referenced by any partner profile or transaction.  To select a key for editing, highlight the Key ID in the list and 
select OK. To move a key, highlight the Key ID and drag it to the target folder in the navigation tree. 

Search Criteria  
Search Criteria are used to find keys where the search field contains a specific phrase or keys that are not 
referenced by any partner or transaction.  
 
NOTE:  The phrase field is case sensitive.  

NOTE:  Leaving the 'containing phrase' field blank displays an unfiltered list of objects. 

The Search Button is used to initiate the search using the criteria in the Search Criteria panel and displays the 
number of keys found. 

Search Results 
Search Results displays all of the keys that match the search criteria. 

Export 
Use the Export button to export search results to a .csv file. 
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6.3.2 OpenPGP Keys Window 

The OpenPGP Keys Window displays information about the selected key.  None of the fields are editable.  Public 
keys appear the same as key pairs. 

6.3.2.1 Key Identification 

 

Key Name  
Displayed by Diplomat MFT each time you select a key for use in a transaction.  Key Name is used only by 
Diplomat.   
 
NOTE: If you export a key, the Key Name is not exported.  

Key Type 
OpenPGP keys have three different types: DH/DSS, RSA, and RSA Legacy. This field displays either DH/DSS or RSA 
as the key type.  If an RSA key is an RSA Legacy key, version ‘3’ is displayed in the version field of the master key or 
sub-key. 

User ID(s) 
Text string that helps identify the owner of the key.  Some OpenPGP products allow you to specify multiple User 
IDs for a single key.  If you export a key, the User IDs are exported.  Users of other OpenPGP products will have 
visibility to the User IDs of a key. 

Key Passphrase  
Passphrase that was set during key creation.  Select the Show Passphrase button to display the passphrase. 
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6.3.2.2 Master Key and Subkey(s) 

 
 
When Diplomat MFT creates a new OpenPGP key using the DH/DSS algorithm, the master key is designated as Sign 
Only and sub-keys are designated as Encrypt Only.  When the RSA algorithm is selected, the master key and the 
sub-keys are able to encrypt and sign files.  Keys created by other OpenPGP products may have master or sub-keys 
that can be used for both signing and encryption.  
 
The title of each Master or Sub-Key panel in the Key window indicates the functions that the key can perform (i.e., 
Sign or Sign and Encrypt).  Each Master Key and Sub-Key displays the following characteristics: 

Algorithm 
Name of the algorithm the master key or sub-key uses at runtime to encrypt/decrypt or sign/verify files.  Each 
master key and sub-key can use a different algorithm.  

Bit Strength 
Bit strength of a key is related to how difficult the algorithm is to break.  The larger the bit strength of a key the 
more difficult and time-consuming the code-breaking task would be. The larger the bit strength of a key, the longer 
it takes to generate and the longer it takes to encrypt, decrypt, sign, or verify a file.  Keys sizes are generally 1024, 
2048, and 4096.  

Created/Starts  
For a Master Key, date key was created.  For Encryption Sub-keys, date the sub-key becomes effective. 

Expires 
Date master key or sub-key expires.  Most keys are set to Never.  NOTE:  Keys created by OpenPGP-compliant 
products other than Diplomat MFT may have sub-keys that expire after the master key expiration date. 
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Key ID 
Uniquely identifies a key pair.  Two key pairs may have the same User ID, but they must have different Key IDs. 
 
NOTE:  A public key that is exported from a key pair has the same Key ID as the original key pair.  Diplomat MFT 
allows a public key and a key pair to have the same Key ID, but two key pairs or two public keys may not have the 
same Key ID. 

Key Fingerprint  
Unique string of numbers and characters used to authenticate a public key.  For example, you might send a trading 
partner your public key.  To authenticate that the public key is yours, they might telephone you and read you the 
key fingerprint. You can confirm whether it is the same fingerprint and, therefore, a valid key or not. 

Version 
Version of IETF OpenPGP specification to which the key conforms.  RSA legacy keys display version ‘3’. 

Symmetric Algorithm(s) 
Symmetric algorithms that the private key of a key pair can use to decrypt a file encrypted using the matching 
public key.  The list is in the preferred order of the key creator (i.e., the first algorithm on the list is the most 
preferred).  At run-time, Diplomat MFT compares the symmetric algorithms listed in the key to the list of 
algorithms currently supported by Diplomat.  Diplomat MFT uses the first algorithm that it supports to encrypt files 
with the key.  Diplomat MFT currently supports AES-256, Triple-DES, and CAST5 for file encryption. 
 
NOTE:  When a key with no algorithm specified is imported, the symmetric algorithm field on the key screen is 
blank. However, when Diplomat MFT uses the key, it defaults to using Triple-DES– even though it is NOT displayed 
on the Open PGP Key Pair screen. 
  
 



DIPLOMAT BASIC EDITION USER GUIDE v8.2 

 

Proprietary and Confidential 
DO NOT DISTRIBUTE 

Copyright ©2005-2019 Coviant Software Corporation.  All Rights Reserved. 
84 

6.4 SSH Keys  

SSH keys are a public key encryption technology.  SSH client keys can assist in authenticating the user attempting 
to access an SFTP server.  SSH host keys are used to authenticate the SFTP server, which ensures that the file 
transfer job is connected to the correct SFTP server.  
 
SSH client or host keys are not required when connecting to an SFTP server.   Contact the SFTP server 
administrator if you are unsure whether an SFTP client key is required for a connection. Verification of SSH host 
keys is always an optional step when connecting to an SFTP server. 

6.4.1 SSH Key Menu Items  

In Diplomat Managed File Transfer, each SSH key has a unique key name.  This name is displayed when you select a 
key to be used in the partner profile panels in a transaction window.  These names should be readily 
understandable.  For example, you might name the SSH key for Acme Foods – ‘Acme Foods SSH Key’. 
 
Diplomat MFT SSH key management allows you to: 

▪ Create SSH client key pairs. 

▪ Import existing SSH client key pairs created by other SSH-compliant products.  See Appendix A: Configuration 
Requirement for a list of compatible SSH-compliant products. 

▪ Manually adding SSH host keys to the Diplomat MFT database. 

▪ Export SSH client public keys. 

▪ Delete SSH client or host keys. 

▪ Recover, search or move SSH client keys. 

NOTE:  All key menu items related to SSH client key pairs require the entry of the secret passphrase for that key 
pair. 



DIPLOMAT BASIC EDITION USER GUIDE v8.2 

 

Proprietary and Confidential 
DO NOT DISTRIBUTE 

Copyright ©2005-2019 Coviant Software Corporation.  All Rights Reserved. 
85 

6.4.1.1 SSH Client Keys 

To use SSH client keys, you must: 

▪ Create an SSH client key pair by selecting Keys > SSH Client Keys > Create Key Pair from the top menu bar. 

▪ Export the public key from the newly-created SSH Client key pair into a file by selecting Keys > SSH Client Keys 
> Export Public Key from the top menu bar. 

▪ Send the public key file to the SFTP server administrator.  

▪ Once the server administrator attaches the public key to the account you use to access the SFTP server, you 
can use the SSH client key to log into the SFTP server by selecting the correct SSH client key on the SFTP panel 
in the Source or Destination Partner Profile when setting up transactions. 

 
During a file transfer to an SFTP server, the SSH client key is used ONLY to authenticate your login.  A different key 
pair generated at run-time by the SFTP server is used to encrypt/decrypt the file being transmitted. 
 
When you attempt to log into an SFTP server using an account that requires an SSH client key, the SFTP server 
automatically uses the public key associated with your account to authenticate your login request.  The SFTP server 
encrypts a random number using the public key associated with your account and sends it to Diplomat.  Diplomat 
MFT uses the private SSH client key pair specified in the transaction to decrypt the number and send it back to the 
SFTP server.  If the SFTP server recognizes the number, it establishes a connection with Diplomat MFT to transfer 
the file.  If the SFTP server does not recognize the number, it refuses the connection. 
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6.4.1.1.1 Create Key Pair 
 

 

Key Name 
SSH key pairs must have unique Key Names in Diplomat.  Key Names are used only by Diplomat.  You should 
choose a name that makes it easy for you to determine the intended use of the key when setting up transactions.  
Key Name field length is limited to 64 characters.  

Key Type 
Diplomat MFT supports two SSH client key types: DH/DSS and RSA. 

Bit strength 
Bit strength of a key is related to how difficult the algorithm is to break.  The larger the bit strength of the key, the 
more difficult and time-consuming the code-breaking task would be.  The larger the bit strength of the key, the 
longer it takes to generate the key.  Keys sizes are generally 1024, 2048, and 4096. DS/DSS keys only support a 
1024 key size.  RSA keys support 1024, 2048, and 4096 key sizes. 

Passphrase 
SSH uses a passphrase to encrypt your key pair.  A passphrase should be hard for you to forget and difficult for 
others to guess.  
 
You must provide the passphrase, when you import, create, export, delete, or recover an SSH client key pair.  Once 
you have created a key pair in Diplomat, the passphrase is stored in a special encrypted format separately from the 
key pair.  When you set up a transaction in Diplomat, for security purposes, you do not need to re-enter the 
passphrase.  
   

NOTE:  If you attempt to create a key with a Key Name that already exists in the Diplomat MFT database, you have 
the option to replace the existing key with the new key.  If you choose to overwrite the existing key, you cannot 
recover the original SSH key at a later time.  To ensure that you do not permanently delete a key, you can delete 
the SSH key you want to replace.  Then, create a new SSH client key with the same name.  The original SSH client 
key can still be recovered at a later time.  
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6.4.1.1.2 Import Key Pair 
 

 

 

SSH client key pairs from other SSH-compliant products can be imported into Diplomat.  You must export the key 
pair into an individual file using your SSH-compliant product and then import it into Diplomat.   

NOTE:  If you attempt to import a key with an SSH Key Name that already exists in the Diplomat MFT database, you 
have the option to replace the existing key with the new key.  If you choose to overwrite the existing key, you 
cannot recover the original SSH key at a later time.  However, to ensure that you do not permanently delete a 
key, you can delete the SSH key you want to replace.  Then, create a new SSH key with the same name.  The 
original SSH key can still be recovered at a later time.   

SSH Key File  
Enter the filename and location of the SSH client key pair. For Windows systems, the default key directory is 
C:\ProgramData\Coviant Software\Diplomat-j\keys.  For Linux systems, the default directory is 
/opt/coviant/diplomat-j/keys.  Use Browse to select a different directory.  Use Test to determine whether the 
location is accessible and is read/write enabled for the login identity used by the Diplomat MFT Service. 

Key Name 
All keys must have unique Key Names in Diplomat.  Key Names are used only by Diplomat.  Choose a name that 
makes it easy to determine the intended use of the key when setting up transactions.  Key Name field length is 
limited to 64 characters.  

Passphrase 
SSH uses a passphrase to encrypt your private key.  You must provide the passphrase, when you import, create, 
delete, or recover a key pair.  
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6.4.1.1.3 Export Public Key 

 

Public SSH client keys can be exported from Diplomat MFT for use with other SSH-compliant products.  To export a 
public key, select the key you would like to export on the navigation tree. Then, select Keys > SSH Client Keys > 
Export Public Key from the top menu bar.  

To use SFTP for file transfers, you must create an SSH client key pair for use by Diplomat MFT when logging on to a 
particular SFTP server.  Then, you must export the public key from your newly-created SSH client key pair into a file 
and send it to the SFTP server administrator.  The SFTP server administrator must then attach the public key to 
your SFTP account.  

NOTE:  Some older SSH1-based SFTP servers use a different key format when exported to a file. The SFTP (SSH1) 
server may appear to import Diplomat MFT SSH client keys correctly, but login fails.  If you have created a new 
SFTP public key and cannot connect to an SFTP server, contact Coviant Software Support for assistance.  

SSH Client Public Key File 
Browse to the file you plan to use for the public key file.  For Windows systems, the default key directory is 
C:\ProgramData\Coviant Software\Diplomat-j\keys.  For Linux systems, the default directory is 
/opt/coviant/diplomat-j/keys.   

Save as File Type 
All SSH public keys exported by Diplomat MFT have a “.pub” file extension. 
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6.4.1.1.4 Delete 

SSH key pairs can be deleted from the Diplomat MFT keystore.  To delete a key, select the key you plan to delete 
from the navigation tree.  Then, select Keys > SSH Keys > Delete from the menu bar or highlight the SSH key pair in 
the navigation tree. Enter <Ctrl+D> or right-click and select Delete.    

If a transaction in Diplomat MFT references the key you are attempting to delete, Diplomat MFT does not 
immediately delete the key and you receive the message shown below.   

 

It is strongly recommended that you press “Cancel” and manually remove references to the key before proceeding 
with the key deletion. 

Only press “OK” if you are certain that the key and all of the related transactions are no longer needed.  For 
example, you might choose to delete a key and all of its related transactions if you are no longer doing business 
with the trading partner for which you created the key. 

NOTE:  SSH uses a passphrase to encrypt your private key.  You must provide the passphrase, when you import, 
create, or recover a key pair.   

 

If you have forgotten the passphrase and need to delete a key pair, you can force the deletion without a valid 
passphrase. 
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6.4.1.1.5 Recover 

SSH client key pairs can be recovered, if they were deleted by Diplomat.  To recover a key, select Keys > SSH Client 
Keys > Recover from the menu bar.   

NOTE:  SSH uses a passphrase to encrypt your private key.  You must provide the passphrase, when you import, 
create, delete, or recover a key pair.   

 

Recover Checkbox 
Check Recover beside each key pair that you would like to recover. 

Fingerprint 
Uniquely identifies an SSH client key pair.   

Diplomat Key Name 
Diplomat Key Names are used only by Diplomat.  All SSH client key pairs must have unique Diplomat Key Names.   
 
If you attempt to recover an SSH client key pair with a Diplomat Key Name that already exists in the Diplomat MFT 
database, you have the option to overwrite the existing key pair or to modify the Diplomat Key Name field.   
 

 

Recovered Key Passphrase 
Recovered Key Passphrase is the passphrase for the SSH client key pair you plan to recover.   

Overwrite Checkbox 
An Overwrite checkbox is displayed for each SSH client key pair with Diplomat Key Name that already exists in the 
Diplomat MFT database.   
 
NOTE:  If you decide not to overwrite the existing key pair, uncheck the Overwrite checkbox before selecting OK.  

Existing Key Passphrase 
If you plan to overwrite an existing SSH client key pair in the Diplomat MFT database, you must enter the Existing 
Key Passphrase for the existing key.  
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6.4.1.1.6 Search/Move 
 

 
 
SSH client key Search/Move is used to locate SSH client keys containing specific phrases and keys that are not 
referenced by any partner profile or transaction.  To select a key for editing, highlight the Key ID in the list and 
select OK. To move a key, highlight the Key ID and drag it to the target folder in the navigation tree. 

Search Criteria  
Search Criteria are used to find keys where the search field contains a specific phrase or keys that are not 
referenced by any partner or transaction.  
 
NOTE:  The phrase field is case sensitive.  

The Search Button is used to initiate the search using the criteria in the Search Criteria panel and displays the 
number of keys found. 

Search Results 
Search Results displays all of the keys that match the search criteria. 

Export 
Use the Export button to export search results to a .csv file. 
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6.4.2 SSH Client Keys Window 

The SSH Keys Window displays information about the selected key.  None of the fields are editable.   
 

 

Key Name  
Displayed by Diplomat MFT each time you select a key for use in a transaction.  Key Name is used only by 
Diplomat.   

Algorithm  
SSH client keys can use two algorithms: DH/DSS and RSA. This field indicates which algorithm the key will use for 
encryption or decryption. 

Bit Strength 
Number of bits representing the key size.  The difficulty of breaking a key increases as bit strength increases.  

Key Fingerprint  
Unique string of numbers and characters used to authenticate a public key.  For example, you would be likely to 
export a public key and send to an SFTP server administrator.  To authenticate that the public key is yours, the 
administrator might telephone you and read you the key fingerprint. You can confirm whether it is the same 
fingerprint and, therefore, the correct key. 

Key Passphrase  
Passphrase that was set during key creation.  Select the Show Passphrase button to display the passphrase. 
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6.4.3 SSH Host Keys 

 
When you attempt to log into an SFTP server, you can have Diplomat MFT verify the identity of the SFTP server by 
comparing the fingerprint supplied by the SFTP server with the fingerprints in the Diplomat MFT database. 

To use SSH host keys, you must: 

▪ Add the host address and fingerprint of the SFTP server to the SSH host key list in Diplomat MFT under Keys > 
SSH Host Keys from the top menu or when using the Test button in a partner profile. 

▪ Check Verify SSH host key on the SFTP panel in the Source or Destination Partner Profile when setting up 
transactions. 

▪ Use the Show SSH Host Keys on the same panel to verify that the host address and fingerprint are shown in 
the SSH host key list. 

 

NOTE:  When you use the Test button on the partner profile panel and the correct SSH host key is not in the SSH 
host key list, you will be prompted to add the SSH host key to the list. 
 

 
 

Select the Add button to enter host addresses and fingerprints for SSH Host Keys.  Select the Delete button to 
remove the host address and fingerprint from the Diplomat MFT database. 
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6.5 SSL Certificates 

SSL Certificates are used to confirm the identity of an FTPS (TLS) server when a file transfer job runs.  The FTPS 
server administrator decides whether an SSL certificate is required.  And, if so, they send a certificate file to you 
that must be imported into Diplomat. 

If an SSL certificate is required, you must: 

▪ Request an SSL certificate file from the FTPS server administrator.  Typically, this file can be emailed to you. 

▪ Import the SSL certificate by electing Keys > SSL Certificates > Import SSL Certificate from the top menu bar. 

▪ Select the certificate from the SSL Server Certificate drop-down list in the FTPS (TLS) Server sub-panel on the 
Transaction screen. 

 
During a file transfer to an FTPS server, the SSL server certificate is only used to verify the identity of the FTPS 
server.  A different key pair generated at run-time by the FTPS server is used to encrypt/decrypt the file being 
transmitted. 
 

6.5.1 SSL Certificates Menu Items  

In Diplomat Managed File Transfer, each SSL certificate has a unique key name.  This name is displayed when you 
select a key to be used in the partner profile panels in a transaction window.  These names should be readily 
understandable.  For example, you might name the SSL Certificate for Acme Foods FTPS server– ‘Acme Foods SSL 
Cert’. 
 
Diplomat MFT SSL certificate management allows you to: 

▪ Import existing SSL certificates. 

▪ Delete SSL certificates. 

▪ Search or move SSL certificates. 

6.5.1.1 Import SSL Certificate 
 

 

SSL certificates can be imported into Diplomat.  Typically, you would receive an SSL certificate file from the FTPS 
server administrator.  

NOTE:  If you attempt to import an SSL certificate with an SSL Certificate Name that already exists in the Diplomat 
MFT keystore, you have the option to replace the existing certificate with the new certificate.  If you choose to 
overwrite the existing certificate, you cannot recover the original SSL certificate at a later time.   
 
Browse to the location of the SSL certificate file and select the filename.  For Windows systems, the default 
directory is C:\ProgramData\Coviant Software\Diplomat-j\certs.  For Linux systems, the default directory is 
/opt/coviant/diplomat-j/certs.   
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6.5.1.2 Save  

Select Keys > SSL Certificates > Save from the top menu bar, enter <Ctrl+S>, or right-click the key in the left 
navigation and select Save.   

6.5.1.3 Reset  

Select Keys > SSL Certificates > Reset from the top menu bar, enter <Ctrl+R>, or right-click the key in the left 
navigation and select Reset. 

6.5.1.4 Delete 

SSL certificates can be deleted from the Diplomat MFT datastore.  To delete an SSL certificate, highlight the 
certificate you plan to delete from the navigation tree. Then, select Keys > SSL Certificates > Delete from the top 
menu bar.  Enter <Ctrl+D> or right-click and select Delete.   

   

Only press “OK” if you are certain that the certificate is no longer needed.  For example, you might choose to 
delete a certificate if you are no longer doing business with the trading partner from which you received the 
certificate. 
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6.5.1.5 Search/Move 
 

 
 
SSL Certificate Search/Move is used to locate SSL certificates containing specific phrases and keys that are not 
referenced by any partner profile or transaction.  To select a certificate for editing, highlight the Key ID in the list 
and select OK. To move a certificate, highlight the Key ID and drag it to the target folder in the navigation tree. 

Search Criteria  
Search Criteria are used to find certificates where the search field contains a specific phrase or keys that are not 
referenced by any partner or transaction.  
 
NOTE:  The phrase field is case sensitive.  

NOTE:  Leaving the 'containing phrase' field blank displays an unfiltered list of objects. 

The Search Button is used to initiate the search using the criteria in the Search Criteria panel and displays the 
number of certificates found. 

Search Results 
Search Results displays all of the certificates that match the search criteria. 

Export 
Use the Export button to export search results to a .csv file. 
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6.5.2 SSL Certificate Window 

The SSL Certificate displays information about the selected certificate.  None of the fields are editable.   
 

 

Certificate Name  
Displayed by Diplomat MFT each time you select a certificate for use in a transaction or partner profile.  Certificate 
Name is used only by Diplomat.   

Version, Serial Number, Valid From/To, Issuer and Subject 
SSL Version, Serial Number, Valid From/To, Issuer and Subject are set at the time the certificate was created. 
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7 Understanding Transactions  

7.1 Transactions Overview 

Transactions are file transfers that are either outbound to a trading partner/remote site or inbound from a trading 
partner/remote site.   
 
Transactions are at the core of Diplomat MFT functionality and define all characteristics that govern a particular 
file transfer, including: 

▪ Source name of the file being transferred and, if different, the destination filename 

▪ Source and destination profiles, including file location, transport method (FTP, FTPS, SFTP, or local network), 
and associated login information 

▪ OpenPGP keys to encrypt/decrypt and sign/verify 

▪ File handling characteristics 

▪ Job scheduling information 

▪ Archiving for storing copies of files  

▪ Advanced troubleshooting 
 
The transaction window contains all information needed to encrypt, sign, and send a file for outbound transactions 
or pick-up, decrypt, and verify a file for inbound transactions.  You may create multiple transactions each 
encrypting and moving a single file or you may create one transaction to encrypt and move a group of files.  
Information entered in a transaction window is specific to an individual transaction and has no effect on any other 
transaction.   
 
The Diplomat MFT transaction database is a SQL database that contains transaction, key, and configuration data.  
You can backup or restore these files as a group by selecting File > Backup or File > Restore.   
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7.2 Transactions Navigation Tree 

The navigation tree shows the Transaction Names of all transactions currently in the Diplomat MFT transaction 
database.  The transactions are divided into sub-folders for inbound and outbound transactions. Typically, inbound 
transactions are for file transfers where your company is receiving files from a trading partner.  Outbound 
transactions are for files transfers where your company is sending files to a trading partner. 
 
Select a sub-folder under Transactions in the navigation tree and right-click to create a new transaction in the 
folder, add a sub-folder, expand all sub-folders, collapse all sub-folders, rename the folder, delete the folder or 
search/move the folder. 
 
Select a transaction in the navigation tree and right-click to save changes to the transaction, save the transaction 
with a new name, reset the settings in the transaction to the saved values, validate the transaction values, view log 
entries from the most recent job run, run a transfer job from the transaction, rename the transaction, delete the 
transaction, or move the transaction to a new folder. 
 

7.3 Transactions Menu Items 

The drop-down menu from Transactions on the menu bar allows you to create, save, delete or search transactions.   

7.3.1 Create Inbound/Outbound  

New inbound and outbound transactions are created using the drop-down menu from the Transaction button on 
the menu bar.  Newly created transactions are set automatically to Do Not Run. 
 
You will be prompted to enter a Transaction Name, which must be unique across all inbound and outbound 
transactions.  A Transaction Name may not contain any of the following characters: * ? / \ | " : < >. 
 
NOTE:  If you attempt to create a new transaction using a name that already exists in the Diplomat MFT 
transaction database, you will be warned before the existing transaction is overwritten.   
 

 
 
NOTE:  You cannot overwrite an inbound transaction with the same name as an outbound transaction or vice 
versa.  For example, assume you have a Diplomat MFT database containing an inbound transaction with a 
Transaction Name of ‘Transaction 1’.  You could not create a new outbound transaction or save an existing 
outbound transaction with the Transaction Name of ‘Transaction 1’. 
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7.3.2 Save/Save As 

A transaction can be saved using the drop down menu from the Transaction menu item on the menu bar or by 
entering <Ctrl+S>. If you have not already saved the transaction, you are prompted to save it upon exit from 
Diplomat.  You must save a transaction before you exit from the Diplomat MFT Client in order to retain 
information entered during the session.   
 
You may not change the Transaction Name of a transaction once it has been created, but you can use Save As on 
the transaction drop-down to save it under another name, then delete the original transaction using Delete on the 
same drop-down menu.  When using Save As, the new Transaction Name may not contain any of the following 
characters: * ? / \ | " : < >. 
 
New transactions created using Save As are set to Do Not Run.  
 
NOTE:  If you attempt to create a new transaction using Save As with a name that already exists in the Diplomat 
MFT transaction database, you will be warned before the existing transaction is overwritten.   

7.3.3 Reset  

Select Transactions > Reset from the top menu bar, enter <Ctrl+R>, or right-click the transaction in the left 
navigation and select Reset. 

7.3.4 Delete 

You may delete a transaction using the drop down menu from the Transactions menu item on the menu bar or by 
entering <Ctrl+D>, or right-click and select Delete.    
 
Transaction deletions are permanent.  The only way to recover a transaction is to restore a previously saved 
backup of the entire Diplomat MFT transaction database.  The database contains only the keys and transactions as 
of the date the backup was done.  Any changes to the database since the backup was saved are lost. 
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7.3.5 Search/Move 

 
 
Transaction Search/Move dialog is used to locate and move or edit specific transactions.   
 
To access Search/Move, select Transactions > Search/Move from the top menu bar, enter <Ctrl+T>, or right-click 
transaction folder in the left navigation and select Search/Move. 
 
To select a transaction for editing, double-click on the Transaction Name in the inbound or outbound list.  To move 
a transaction, highlight the Transaction Name and drag it to the target folder in the navigation tree. 

Search Criteria  
Search Criteria are used to find transactions where the search field contains a specific phrase, that have not 
processed files for a specified number of days, or that have no records in the job history database.  
 
NOTE:  The phrase field is case sensitive.  
 
NOTE:  Leaving the 'containing phrase' field blank displays an unfiltered list of objects. 

The Search Button is used to initiate the search using the criteria in the Search Criteria panel and displays the 
number of transactions found. 

Search Results 
Search Results displays all of the inbound and outbound transactions that match the search criteria.   

Export 
Use the Export button to export search results to a .csv file. 
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7.4 Transactions Window 

The transaction window is separated into panels covering the types of information necessary to fully-specify a 
transaction, including transaction identification, file, source and destination, keys, job schedule, and archive 
information. 
 

Some of the panels can be maximized and minimized using the  and  buttons located in the top, right 
corner of each panel.  
 
NOTE:  Newly created transactions are displayed with all panels maximized.  Previously-saved transactions are 
displayed with all panels minimized. 

7.4.1 Transaction Identification 

 
 

Transaction Name 
Name of the transaction.  Must be a unique name across all inbound and outbound transactions.  A Transaction 
Name may not contain any of the following characters: * ? / \ | " : < >.  Transaction Name field length is limited to 
110 characters. 

Description 
Descriptive overview to help recognize the transaction. 
 



DIPLOMAT BASIC EDITION USER GUIDE v8.2 

 

Proprietary and Confidential 
DO NOT DISTRIBUTE 

Copyright ©2005-2019 Coviant Software Corporation.  All Rights Reserved. 
103 

7.4.2 File Information  

 

 

At run time, the fields in the File Information panel determine which files are to be processed and what actions are 
to be taken with the file(s) during or after transfer.  
 
Potential source files are filtered from all files in the source directory based on whether filenames match a naming 
template that allows wildcards for up to one (?) or multiple (*) characters in the Source File(s) field. 
 
If source files are found that match all of the specified criteria, destination filenames are determined for each file 
in the list of source files based on a naming template that interprets a pipe ‘|’ wildcard in the Destination File(s) 
fields as the source filename. 
 
If each source file has a unique destination filename, processing continues and a list of source and destination 
filenames is created.  Then, the number of source and destination filename pairs is compared to the number of 
files specified.  If the number found matches the number specified in the Number of Files drop-down, the source 
and destination filename pairs are added to the list of files to be processed by the job. 
 
Once the list of source and destination filename pairs has been validated, the following fields affect the processing 
of files: 
▪ If the Delete Source checkbox is checked and a file is transferred successfully, Diplomat MFT attempts to 

delete the source file. 
▪ If the Overwrite settings allow it, a file is written to the destination directory even if a pre-existing file in the 

directory has the same name.  
▪ If the Allow Zero Byte Files checkbox is checked, source files that have zero bytes on outbound jobs and 

destination files that have zero bytes on inbound jobs will continue to be processed.   
▪ If the Fail if File(s) Not Found checkbox is checked, jobs that find no files to be processed will generate a status 

of ‘Failure’ and other related actions will be taken. 

Source File(s) 
Source File(s) fields contain the name(s) of file(s) to be picked up.  NOTE:  Filenames are case sensitive.  

Specifying Sub-Directories to Source Filenames 
A sub-directory can be prepended to the beginning of the filename using ‘/’ or ‘\’ as a delimiter between 
the sub-directory name and the filename.  Do not add a delimiter at the beginning of the sub-directory 
name.  Wildcard characters (* and ?) cannot be used as part of a sub-directory name in a Source File(s) 
field.  NOTE:  Sub-directories are case sensitive. 

Using Wildcards in Source File(s) Fields 
The asterisk ‘*’, the question mark ‘?’ and double asterisks ‘**’ are the only wildcard characters 
recognized in Source File(s) fields.  
 
To specify multiple files in a Source File(s) field, substitute a single ‘?’ to wildcard single characters or an 
asterisk to wildcard multiple characters in the filename.  For example, ‘diplomat*.txt’ returns all files 
starting with ‘diplomat’ that have a ‘.txt’ extension.   
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Double asterisks indicate that directory structures and all files under the source directory will be 
replicated at the destination.   
 
NOTE:  When using a double asterisk wildcard, no destination file renaming is enabled other than the 
default of adding or removing .pgp and .asc during file encryption, decryption, signing or verification. This 
automatic file renaming cannot be overridden. 
 
NOTE:  The double asterisk wildcard is not supported by FTP servers that do not allow the LIST command. 

Destination File(s) 
Each Destination File(s) field is always associated with a matching Source File(s) field and determines the name(s) 
of file(s) as they are to be written to the local network or FTP server directory specified in the Destination Partner 
Profile panel.   
 
Enter data in this field only if you want the destination filename(s) to be different than the original source 
filename(s).   
 
NOTE:  Filenames are case sensitive. 

NOTE:  After constructing destination filenames, if any 2 or more are identical INCLUDING capitalization, the file 
transfer job will fail. 

Specifying Sub-Directories for Destination Filenames 
A sub-directory can be prepended to the beginning of the filename using ‘/’ or ‘\’ as a delimiter between 
the sub-directory name and the filename.  Do not add a delimiter at the beginning of the sub-directory 
name. If no characters follow the sub-directory name and ‘/’ or ‘\’, the destination file(s) will be written to 
the specified sub-directory with default names as described below.  NOTE:  Sub-directories are case 
sensitive. 
 
NOTE:  Any sub-directory entered as part of the source filename is ignored in the default for the 
destination filename. 

Default Destination Filenames 
For inbound transactions, if a destination filename is not specified, the filename defaults to the original 
filename with the .pgp, .gpg, or .asc extension, if any, removed.   
 
For outbound transactions, file extensions are added depending on whether a file is encrypted, signed, 
and/or ASCII-armored as summarized below:  
 

 File Processing Extension 

No encryption or signature <none> 

Encrypt or sign .pgp 

ASCII armor (with or without encrypt or sign) .asc 

Using Wildcards in Destination File(s) Fields 
The pipe ‘|’ character is the only wildcard recognized in Destination File(s) fields.  The pipe ‘|’ character 
indicates the original source filename when the destination filename is constructed.  Additional characters 
may precede or be appended to the original source filename.   

 
NOTE:  On inbound transactions where a file is being decrypted, verified, and/or having ASCII-armoring 
removed, the ‘|’ wildcard represents the incoming filename without a .pgp, .gpg, or .asc file extension, if 
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any.  If a file with .pgp, .gpg, or .asc extension is treated as transferred with no changes, the file extension 
is not removed. 
 
NOTE:  Only one ‘|’ wildcard can be used in a Destination File(s) field.  
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Number of File(s) 
The Number of File(s) field is associated with the Source File(s) and a Destination File(s) fields.  When a wildcard is 
used as part of the source filename, the Number of File(s) field is enabled.  If not, the Number of File(s) field is 
disabled and set to ‘1’.   
 
If Number of File(s) is specified and a Diplomat MFT job does not find exactly the number of files specified, the 
transaction does not continue.  If Fail if File(s) Not Found is checked, then the transaction fails.  If Fail if File(s) Not 
Found is not checked, then the job is simply rescheduled. 
 
NOTE:  When Number of File(s) is ‘1’, you can enter a fixed, single filename in the Destination File(s) field  in 
addition to using the pipe wildcard ‘|’ in the field.  

Delete Source 
If Delete Source is checked, Diplomat MFT attempts to delete source file(s).  Some FTP servers do not allow server-
side delete.  If so, files are not deleted.  If you experience problems deleting files from an FTP server, contact the 
FTP server manager. 

Allow Zero Byte Files 
If Allow Zero Byte Files is checked, source files that have zero bytes on outbound jobs and destination files that 
have zero bytes on inbound jobs will continue to be processed as if they were valid files.  File renaming and file 
handling steps, such as encrypt, decrypt, sign, verify, and adding ASCII-armor, occur as if the file were not zero 
bytes. 
 
NOTE:  Zero byte files may cause some applications to fail.  Allow Zero Byte Files should be checked only if the 
receiving application(s) can correctly handle zero byte files, including ones that may have been encrypted, signed, 
compressed, and/or ASCII-armored. 
 
NOTE:  Zero byte files that have been encrypted or signed by PGP Command Line Server or McAfee e-Business 
Server typically cannot be decrypted.  If you or a trading partner uses a PGP command line tool to decrypt or verify 
files, test whether zero byte files can be successfully decrypted and verified before checking Allow Zero Byte File(s). 

Overwrite 
Overwrite settings allow you to select the conditions under which you want to allow destination files to be 
overwritten.  Default value is Do Not Overwrite. 

NOTE:  If Do Not Overwrite is selected and the destination directory contains a file with the same name as a file 
being transferred, the file is not overwritten, the job ends with a WARNING status.  If any other overwrite setting is 
selected and files are not overwritten, the job does not generate a warning and ends with a SUCCESS status. 
 
Values are: 

▪ Overwrite 
▪ Overwrite if newer 
▪ Overwrite if file size different  
▪ Overwrite if newer or file size different 
▪ Do not overwrite 

Fail if File(s) Not Found 
Check Fail if File Not Found, if you expect one or more valid files to be found every time a job for this transaction is 
executed.  Valid files conform to all of the settings in the File Information panel, such as having a particular name 
and finding the number of files specified.  When Fail if File Not Found is not checked, jobs that do not find any files 
to transfer are simply rescheduled. 
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NOTE:  If a job fails unexpectedly due to File Not Found, check the log file for the exact listing of filenames in the 
source directory.  Confirm that the file and directory names on the transaction are identical to the names on the 
source or destination system.  All file and directory names are CASE SENSITIVE.  If the names do not match exactly, 
the file will not be found.   
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7.4.3 Source Partner Profile 

 

Transport Method 
Determines whether the source file is on the local network or on an FTP server.  If Transport Method is Local 
Network, the Local Network panel is displayed.  If the Transport Method is FTP, SFTP (SSH2), or FTPS (SSL), an FTP 
Server panel is displayed. 

Description 
Descriptive overview to help recognize the partner profile. 
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7.4.3.1  FTP/S  

 

Address 
Address of the FTP/S server where the source file(s) are found.  

Port 
Specifies a port number as required by the FTP/S server to be used for the FTP session. Contact the FTP/S server 
administrator to obtain this information. 

Test Button 
After entering the FTP/S server information, press Test to: 
◼ Test the connection to the FTP/S server  
◼ Determine whether the username and password are valid 
◼ Display the default directory and its contents 

 

Username 
Name used to log in to the FTP/S server where transaction file(s) are to be found.  Logging in under a username 
defaults to a particular directory on the FTP/S server.  
 
NOTE: Some FTP/S servers allow anonymous login.  If so, enter ‘anonymous’ in this field.  It is recommended that 
FTP/S servers require a username and password before gaining access to the server for uploading or downloading 
files.   

Password 
Password used to log in to the FTP server.  If you are using anonymous login, enter your email address or other 
identifier.  Select the Show Password button to display the password. 

Account 
Some FTP/S servers require an account ID in addition to a username and password.  If required by the FTP/S 
server, enter the account ID.  Otherwise, leave the field blank.  Contact the FTP/S server administrator to obtain 
this information. 
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Directory  
Directory on the FTP/S server where transaction file(s) are found.  When an FTP/S session is initiated, a change 
directory command (CWD) is issued with this string as the argument. If the FTP/S server is set up to automatically 
point to the directory required by this transaction, leave this field blank.   
 
NOTE:  For AS/400 IFS systems, this directory path must always start with a ‘/’.  If a directory path for an AS/400 IFS 
system is entered that does not start with a slash, Diplomat MFT processes the transaction as if a ‘/’ were 
prepended to the beginning of the directory path.  For AS/400 IFS systems, if the field is blank, Diplomat MFT uses 
“/” as the directory. 
 
NOTE:  For AS/400 Library systems, this field must be blank.  AS/400 Library systems do not support directories. 
 
NOTE:  Except for AS/400 Library systems, you may specify a sub-directory from this directory in the Source or 
Destination File(s) fields for an individual transaction.   

Timeout 
Sets the length of time the Diplomat MFT Service waits for a response from the FTP/S server. 

SITE Command 
Specifies the content of SITE command to be issued after login on an FTP/S server and before file transfer is 
initiated. 
 
NOTE:  SITE commands are unique to each FTP/S server.  Contact the FTP/S server administrator to determine 
which SITE commands are supported and/or required. 

Server Type 
Select Windows/Unix, AS400/IFS, AS400/Library, or MVS/IFS.  Selecting AS400/IFS enables transactions with the 
Integrated File System (IFS) only.  Selecting AS400/Library enables transactions with the AS/400 Library file system 
only. 

SSL Server Certificate 
Select an SSL server certificate if you want to validate the certificate sent by an FTPS server when an FTPS session is 
initiated. This setting applies to FTPS (TLS) transport method only.  If FTP is selected, this checkbox is disabled. 
 
NOTE: Typically, you need to request the SSL server certificate from the FTPS server administrator.  Then, you must 
import the certificate into Diplomat.  Select Keys > SSL Server Certificates > Import SSL Certificate and browse to 
the file containing the SSL server certificate received from the FTPS server administrator. 

Passive/Active  
Since most FTP/S servers operate in passive mode, the default for this parameter is Passive.  
 
NOTE:  FTPS (TLS) servers seldom operate in active mode, since firewalls are often not able to correctly route FTP 
traffic that has been encrypted via TLS.   

Explicit/Implicit SSL (FTPS only) 
Option when using FTPS (TLS) as the Transport Mode.  When Explicit SSL selected for FTPS (TLS) transactions, 
Diplomat MFT uses the default FTP port, usually 21, and establishes the TLS link by issuing a command after 
establishing a connection.  When Implicit SSL is selected, Diplomat MFT begins a TLS connection as soon as it logs 
in to an FTP server.  The FTP server must define a specific port for implicit SSL, usually port 990.  Default is Explicit 
SSL. 

CCC (Clear Command Channel) (FTPS only) 
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Check Clear Command Channel to encrypt sensitive information including your username and password then 
transmit other information such as port and IP information in plaintext. This setting applies to FTPS (TLS) transport 
method only.  If FTP or SFTP is selected, this checkbox is disabled. 
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File Integrity Checking 
Choice of file integrity checking by file size or no file checking after a file transfer. When File Integrity Checking is 
enabled, the size of the source file is compared to the size of the destination file.  The size of the source file before 
the transfer is also compared to the size of the source file after the transfer to ensure that no additional data has 
been written to the source file. 
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7.4.3.2 Local Network  

 

Directory  
Directory on the local network where the source file(s) are found. 

Test Button 
After entering the local network directory information, press Test to: 
◼ Verify that the directory can be found  
◼ Read and/or write access are enabled 
◼ Display the contents of the directory 
   

 
 
CAUTION:  If you have trouble running a transaction in which you specified a UNC path or a mapped drive, the 
logon for the Diplomat MFT Service or diplomatServer daemon may not have the privileges to access the specified 
directory.  Please use Test to confirm that the logon for the Diplomat MFT Service or diplomatServer daemon has 
the required privileges before contacting Coviant Software Support. 

File Integrity Checking 
Choice of file integrity checking by file size or no file checking after a file transfer. When File Integrity Checking is 
enabled, the size of the source file is compared to the size of the destination file.  The size of the source file before 
the transfer is also compared to the size of the source file after the transfer to ensure that no additional data has 
been written to the source file. 

Use File Locking 
Check Use File Locking to attempt to lock the target file during processing. 
 



DIPLOMAT BASIC EDITION USER GUIDE v8.2 

 

Proprietary and Confidential 
DO NOT DISTRIBUTE 

Copyright ©2005-2019 Coviant Software Corporation.  All Rights Reserved. 
114 

7.4.3.3 SFTP  

 

Address 
Address of the SFTP server where the source file(s) are found.  

Port 
Specifies a port number as required by the SFTP server to be used for the SFTP session. Contact the SFTP server 
administrator to obtain this information. 

Test Button 

 
 
After entering the SFTP server information, press Test to: 
◼ Test the connection to the SFTP server. 
◼ Check that an SSH host key has been verified. 

 
NOTE: If the SSH host key from the SFTP server is not in the Diplomat MFT database, then you are prompted 
to add the SSH host key and retest the connection. 
 

  
 

◼ Determine whether the username, password and SSH client key are valid. 
◼ Display the default directory and its contents. 
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Username 
Name used to log in to the SFTP server.  Logging in under a username defaults to a particular directory on the SFTP 
server.  

Password 
Password used to log in to the SFTP server.  If you are using anonymous login, enter your email address or other 
identifier. Accounts with Administrator privileges can select the Show Password button to display the password. 

SSH Client Key 
SSH private key associated with an SFTP account login. 

Verify SSH Host Key 
Check Verify SSH Host Key to check that the SSH Host Key associated with the SFTP server matches an SSH Host Key 
in the list displayed by the Show Host Keys button. 

Show Host Keys Button 
Use the Show Host Keys button to display the list domains and fingerprints associated with the SFTP server.  Show 
Host Keys button is disabled when Verify SSH host key is not checked. 

Directory  
Directory on the SFTP Server where transaction file(s) are found or written.  When an SFTP session is initiated, a 
change directory command (CWD) is issued with this string as the argument. If the SFTP server is set up to 
automatically point to the directory required by this transaction, leave this field blank.  

Timeout 
Sets the length of time the Diplomat MFT Service waits for a response from the SFTP server. 
 

File Integrity  
Choice of file integrity checking by file size or no file checking after a file transfer. When File Integrity Checking is 
enabled, the size of the source file is compared to the size of the destination file.  The size of the source file before 
the transfer is also compared to the size of the source file after the transfer to ensure that no additional data has 
been written to the source file. 
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7.4.4 Destination Partner Profile 

  

Transport Method 
Determines the location of the destination file(s). If Transport Method is Local Network, the Local Network panel is 
displayed.  If the Transport Method is FTP, SFTP (SSH2), or FTPS (SSL), the FTP Server panel is displayed. 

Description 
Descriptive overview to help recognize the partner profile. 
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7.4.4.1 FTP/S  

 

Address 
Address of the  FTP/S server where the destination file(s) are written.  

Port 
Specifies a port number as required by the FTP/S server to be used for the FTP/S session.  Contact the FTP/S server 
administrator to obtain this information. 

Test Button 
After entering the FTP/S server information, press Test to: 
◼ Test the connection to the FTP server  
◼ Determine whether the username and password are valid 
◼ Display the default directory and its contents 

 

Username 
Name used to log in to the FTP/S server where destination file(s) are written.  Logging in under a username 
defaults to a particular directory on the FTP/S server.  
 
NOTE: Some FTP/S servers allow anonymous login.  It is recommended that FTP/S servers require a username and 
password before gaining access to the server for uploading or downloading files.   

Password 
Password used to log in to the FTP/S server.  If you are using anonymous login, enter your email address or other 
identifier.  Select the Show Password button to display the password. 
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Account 
Some FTP/S servers require an account ID in addition to a username and password.  If required by the FTP/S 
server, enter the account ID.  Otherwise, leave the field blank.  Contact the FTP/S server administrator to obtain 
this information. 

Directory  
Directory on the FTP/S server where transaction file(s) are written.  When an FTP/S session is initiated, a change 
directory command (CWD) is issued with this string as the argument. If the FTP/S server is set up to automatically 
point to the directory required by this transaction, leave this field blank.   
 
NOTE:  For AS/400 IFS systems, this directory path must always start with a ‘/’.  If a directory path for an AS/400 IFS 
system is entered that does not start with a slash, Diplomat MFT processes the transaction as if a ‘/’ were 
prepended to the beginning of the directory path.  For AS/400 IFS systems, if the field is blank. Diplomat MFT uses 
‘/’ as the directory. 
 
NOTE:  For AS/400 Library systems, this field must be blank.  AS/400 Library systems do not support directories. 
 
NOTE:  Except for AS/400 Library Systems, you may specify a sub-directory from this directory in the Source or 
Destination File(s) fields for an individual transaction.  

Timeout 
Sets the length of time the Diplomat MFT Service will wait for a response from the FTP server. 

SITE Command 
Specifies the content of SITE command to be issued after login on an FTP/S server and before file transfer is 
initiated. 
 
NOTE:  SITE commands are unique to each FTP/S server.  Contact the FTP/S server administrator to determine 
which SITE commands are supported and/or required. 

Server Type 
Select Windows/Unix, AS400/IFS, AS400/Library, or MVS/IFS.  Selecting AS400/IFS enables transactions with the 
Integrated File System (IFS) only.  Selecting AS400/Library enables transactions with the AS/400 Library file system 
only. 

SSL Server Certificate (FTPS only) 
Select an SSL server certificate if you want to validate the certificate sent by an FTPS server when an FTPS session is 
initiated. This setting applies to FTPS(TLS) transport method only.  If FTP is selected, this checkbox is disabled. 
 
NOTE: Typically, you need to request the SSL server certificate from the FTPS server administrator.  Then, you must 
import the certificate into Diplomat.  Select Keys > SSL Certificates > Import SSL Certificate and browse to the file 
containing the SSL server certificate received from the FTPS server administrator. 

Passive/Active  
Since most FTP/S servers operate in passive mode, the default for this parameter is Passive.  
 
NOTE:  FTPS (TLS) servers seldom operate in active mode, since firewalls are often not able to correctly route FTP 
traffic that has been encrypted via TLS.   

Explicit/Implicit SSL (FTPS only) 
Option when using FTPS (TLS) as the Transport Mode.  When Explicit SSL selected for FTPS (TLS) transactions, 
Diplomat MFT uses the default FTP port, usually 21, and establishes the TLS link by issuing a command after 
establishing a connection.  When Implicit SSL is selected, Diplomat MFT begins a TLS connection as soon as it logs 
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in to an FTP server.  The FTP server must define a specific port for implicit SSL, usually port 990.  Default is Explicit 
SSL. 
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CCC (Clear Command Channel) (FTPS only) 
Check Clear Command Channel to encrypt sensitive information including your username and password then 
transmit other information such as port and IP information in plaintext. This setting applies to FTPS(TLS) transport 
method only.  If FTP or SFTP is selected, this checkbox is disabled. 

File Integrity Checking 
Choice of file integrity checking by file size or no file checking after a file transfer. When File Integrity Checking is 
enabled, the size of the source file is compared to the size of the destination file.  The size of the source file before 
the transfer is also compared to the size of the source file after the transfer to ensure that no additional data has 
been written to the source file. 

Attempt to Create New Folders 
Check Attempt to Create New Folders if you are writing to an FTP, FTPS, or SFTP server and want Diplomat MFT to 
create a new folder or folders under the default directory.  Uncheck this setting to prevent Diplomat MFT from 
attempting to create new folders.  
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7.4.4.2 Local Network  

 

Directory  
Directory on the local network where the destination file(s) are written.  If the directory does not exist, Diplomat 
MFT attempts to create a directory as part of a file transfer job.  If Diplomat MFT is successful in creating the 
directory, the job continues as if the directory had already existed. 

Test Button 
After entering the local network directory information, press Test to: 
◼ Verify that the directory can be found  
◼ Read and/or write access are enabled 
◼ Display the contents of the directory 
   

 
 
CAUTION:  If you have trouble running a transaction in which you specified a UNC path or a mapped drive, the 
logon for the Diplomat MFT Service or diplomatServer daemon may not have the privileges to access the specified 
directory.  Please use Test to confirm that the logon for the Diplomat MFT Service or diplomatServer daemon has 
the required privileges before contacting Coviant Software Support. 

File Integrity Checking 
Choice of file integrity checking by file size or no file checking after a file transfer. When File Integrity Checking is 
enabled, the size of the source file is compared to the size of the destination file.  The size of the source file before 
the transfer is also compared to the size of the source file after the transfer to ensure that no additional data has 
been written to the source file. 

Use File Locking 
Check Use File Locking to attempt to lock the target file during processing. 
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7.4.4.3 SFTP  

 

Address 
Address of the SFTP server where the destination files are written.  

Port 
Specifies a port number as required by the SFTP server to be used for the SFTP session. Contact the SFTP server 
administrator to obtain this information. 

Test Button 

 
After entering the SFTP server information, press Test to: 
◼ Test the connection to the SFTP server. 
◼ Check that an SSH host key has been verified. 

 
NOTE: If the SSH host key from the SFTP server is not in the Diplomat MFT database, then you are prompted 
to add the SSH host key and retest the connection. 
 

  
 

◼ Determine whether the username, password and SSH client key are valid. 
◼ Display the default directory and its contents. 
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Username 
Name used to log in to the SFTP server.  Logging in under a username defaults to a particular directory on the SFTP 
server.  

Password 
Password used to log in to the SFTP server.  If you are using anonymous login, enter your email address or other 
identifier. Accounts with Administrator privileges can select the Show Password button to display the password. 

SSH Client Key 
SSH private key associated with an SFTP account login. 

Verify SSH Host Key 
Check Verify SSH Host Key to check that the SSH Host Key associated with the SFTP server matches an SSH Host Key 
in the list displayed by the Show Host Keys button. 

Show Host Keys Button 
Use the Show Host Keys button to display the list domains and fingerprints associated with the SFTP server.  Show 
Host Keys button is disabled when Verify SSH host key is not checked. 

Directory  
Directory on the SFTP Server where transaction file(s) are found or written.  When an SFTP session is initiated, a 
change directory command (CWD) is issued with this string as the argument. If the SFTP server is set up to 
automatically point to the directory required by this transaction, leave this field blank.  

Timeout 
Sets the length of time the Diplomat MFT Service waits for a response from the SFTP server. 

File Integrity  
Choice of file integrity checking by file size or no file checking after a file transfer. When File Integrity Checking is 
enabled, the size of the source file is compared to the size of the destination file.  The size of the source file before 
the transfer is also compared to the size of the source file after the transfer to ensure that no additional data has 
been written to the source file. 

Attempt to Create New Folders 
Check Attempt to Create New Folders if you are writing to an SFTP server and want Diplomat MFT to create a new 
folder or folders under the default directory.  Uncheck this setting to prevent Diplomat MFT from attempting to 
create new folders. 
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7.4.5 File Handling  

The information in the File Handling panel determines how a file is transformed during a file transfer job.   
 

 

 

 

 

Encrypt/Decrypt 
If Encrypt or Decrypt is not checked, the encryption or decryption step of the transaction is omitted and the 
OpenPGP Encryption Key or OpenPGP Decryption Key field is disabled.  Default value is checked. 

OpenPGP Encryption/Decryption Key  
Either the public encryption key of the entity receiving the encrypted file or the key pair used to decrypt the file.  
Contact your trading partner to obtain their public key for encryption.   
 
The drop-down menu displays only keys that have a currently valid encryption sub-key.  For decryption, only key 
pairs are available for selection. 

Sign/Verify 
If Sign or Verify is not checked, the signature or verification step of a file transfer job is omitted and the Signature 
or the Verification Key field is disabled.  Default value is checked.  

One-Pass Signature 
For outbound jobs ONLY, if One-Pass Signature is checked, the target file is processed in a single pass for both 
encryption and signing.   
 
NOTE:  One-pass signatures may not be supported by older PGP implementations. Newer implementations may 
require it. If you have trouble decrypting or verifying files created using one-pass signatures, please contact your 
trading partner to confirm their PGP decryption tool supports this feature. 

OpenPGP Signature/Verification Key  
Either your OpenPGP key pair to be used to sign the file or the OpenPGP public key that matches the key pair your 
trading partner used to sign the file.   
 
The drop-down menu displays only OpenPGP keys that have a currently valid signing sub-key.  For signature keys, 
only key pairs are available for selection. 

Outbound Transaction 

Inbound Transaction 
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Add/Remove ASCII Armoring 
Adds/removes ASCII armoring during the encryption/decryption process.  This format represents binary data using 
only printable ASCII characters and enables you to send encrypted files to or receive encrypted files from systems 
that do not support binary files.  
 
NOTE:  If an inbound transaction is set to Remove ASCII Armoring and an inbound file is not ASCII-armored, the file 
transfer job will fail.  If an inbound transaction is not set to Remove ASCII Armoring and the file is ASCII-armored, 
the file transfer job will fail. 

Compress 
Compresses files as part of the encryption, signing, and/or ASCII-armoring process to reduce file size for transfer or 
storage.  If a file is not being encrypted, signed, or ASCII-armored, the Compress field is disabled.   
 
This field is available only for outbound transactions.  On inbound transactions, files are automatically 
decompressed as part of the decryption and/or verification process. 

Convert to Canonical Text 
Converts an ASCII source file such that each line ends with a carriage return and linefeed before the file is 
encrypted, signed, or ASCII-armored.   
 
This field is available only for outbound transactions. 
 
Canonical text assists in ensuring that your file is readable by the system that receives it.  You need to check 
Canonical Text when your expected files contain ASCII text, since ASCII text is represented differently on different 
systems. For example, on an MSDOS system, all lines of ASCII text are terminated with a carriage return followed 
by a linefeed. On a UNIX system, all lines end with just a linefeed. On a Macintosh, all lines end with just a carriage 
return.  Canonical text has a carriage return and a linefeed at the end of each line of text and is readable by all 
systems.  

Source/Destination File Format 
Indicates ASCII or Binary as the format of the source files before they are picked up by Diplomat MFT and as the 
format of the destination files when they are dropped off by Diplomat.   
 
These fields default to Binary. 
 
Diplomat MFT automatically updates the default values of the Source and Destination File Format fields based on 
other file handling parameters, as follows: 
 

▪ If an inbound transaction is set to decrypt or verify files with no ASCII-armoring, source file format is 
always set to Binary.   

▪ If an inbound transaction is set to remove ASCII-armoring, source file format is always set to ASCII. 
▪ If an outbound transaction is set to encrypt or sign files with no ASCII-armoring, destination file format is 

always set to Binary.   
▪ If an outbound transaction is set to add ASCII-armoring, destination file format is always set to ASCII.   
▪ On all transactions where no file transformation is indicated, the source and destination file must always 

be the same format. 
 
NOTE:  Diplomat MFT uses the Source and Destination File Format fields to set FTP transfer type on file transfer 
jobs using FTP.  If an ASCII file is transferred using FTP with a file format of ‘Binary’, the receiving system may not 
be able to read the file properly.  If a Binary file is transferred with a file format of ASCII, the FTP server may 
automatically add carriage return or linefeed characters and corrupt the file.   

Add Integrity Protected Packet 
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Check Add Integrity Protected Packet to include an Integrity Protected Packet in a PGP-encrypted file. Refer to 
RFC4880, the OpenPGP specification, for additional details. 
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7.4.6 Job Execution  

 
Job Execution parameters determine how frequently file transfer jobs run and on what schedule.  When a file 
transfer job is initiated, it is placed in a scheduling queue and waits for an available slot to begin execution.  

Do Not Run  
If Do Not Run is checked, then file transfer jobs based on the transaction information are NEVER scheduled to run. 
  
NOTE:  Do Not Run is always checked for newly created transactions.  

Run Now Button 
Run Now immediately executes a file transfer job using the current transaction information.  When the job 
completes, the pop-up dialog box displays the same information that you would normally receive in SUCCESS or 
FAILURE email messages. Run Now uses the settings shown in the transaction window – even if the transaction has 
not been saved. 
 
NOTE:  Run Now executes a job immediately – even if a transaction is suspended. 
 
NOTE:  Run Now is disabled when using a preview license.   
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7.4.6.1 Diplomat Scheduler 

The Diplomat Scheduler panel contains the settings Diplomat uses to schedule file transfer jobs. 

7.4.6.1.1 Schedule Settings 
 

Schedule Settings are enabled only if Run Jobs Using Schedule is selected. 

Recurrence Type   
Recurrence Type defines how frequently jobs are scheduled.  You can specify Minutes, Hours, Daily, Weekly or 
Monthly.  
NOTE:  The Diplomat MFT Service checks the system time every 5 minutes to determine whether the system clock 
differs from the expected time by more than 15 minutes.  If so, the Diplomat MFT Service reschedules all file 
transfer jobs using the new system time. 
 
NOTE: At a "spring forward" time when clocks lose the hour between 2am and 3am, daily and monthly jobs 
normally scheduled during that hour will run between 3am and 4am.  At a "fall back" time change when clocks 
have two time periods between 1am and 2am, daily and monthly jobs will run once in the second hourly period. 

Minutes or Hours 

 

Run Every XX Minutes or Hours 
Interval between file transfer job executions. 

Start Date 
First date that file transfer jobs are scheduled. 

Start Time or Daily Window 
Start Time is the time of day on the Start Date that jobs are scheduled. To run jobs only during 
part of the day, select Daily Window and set the begin and end time for job scheduling. 

View Button 
Displays the first 10 times that jobs will execute.  The Previous 10 and Next 10 buttons enable 
display of more job execution times. 
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Daily 

 

Run Every XX Days 
Interval between file transfer job executions. 

Start Date 
First date that file transfer jobs are scheduled. 

Start Time  
Time of day on the Start Date that jobs are scheduled.  

View Button 
Displays the first 10 times that jobs will execute.  The Previous 10 and Next 10 buttons enable 
display of more job execution times. 
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Weekly 

 

Run Every XX Weeks 
Interval between file transfer job executions. 

Day of Week 
Day of week that file transfer jobs are scheduled. 

Start Date 
First date that file transfer jobs are scheduled. 

Start Time  
Time of day on the Start Date that jobs are scheduled.  

View Button 
Displays the first 10 times that jobs will execute.  The Previous 10 and Next 10 buttons enable 
display of more job execution times. 
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Monthly 

 

Start Date 
First date that file transfer jobs are scheduled. 

Start Time  
Time of day on the Start Date that jobs are scheduled.  

View Button 
Displays the first 10 times that jobs will execute.  The Previous 10 and Next 10 buttons enable 
display of more job execution times. 

Months 
Select the months that jobs are scheduled using Run Every XX Months or by selecting specific 
months. NOTE: When using Run Every XX Months, the first month is determined by the Start 
Date. 

Days  
Select the days within the month to schedule file transfer jobs. 

Days of Month 
Select the number of the day of the month to run or select ‘Last’ for the last calendar 
day of each month. 

Days of Week 
Select which weeks and which days of the week to schedule file transfer jobs. Select 
‘Last’ for the last week of the month. 
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Retries 

Number of Attempts if File(s) Not Found 
Total number of times that Diplomat MFT tries to complete a daily, weekly or monthly job when 
files are not found before declaring an error and rescheduling the job. 

Retry Interval 
Number of minutes Diplomat MFT waits before attempting to run the same file transfer job.   
 

CAUTION: If the Diplomat MFT Service is not running or jobs are suspended at the time set for a daily, weekly or 
monthly file transfer, then the file transfer job is simply rescheduled when the Diplomat MFT Service is restarted.  
For example, if a file transfer job is scheduled monthly on the 1st of the month at 1:30PM and the Diplomat MFT 
Service was not running on the 1st at 1:30PM, then when the Diplomat MFT Service is restarted or jobs are 
released, the next file transfer job for this transaction would be scheduled at 1:30PM on the 1st of the following 
month. 

7.4.6.1.2 Exclusions  
 

Daily Exclusions 
File transfer jobs are not scheduled on days of the week that are checked. 
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7.4.7 Archive 

  
 
Archive files are copies of the files that are transferred by a particular Diplomat MFT job.  Diplomat MFT allows you 
to keep copies of files for all jobs in a centralized location.  You can skip archiving for an individual transaction by 
checking the Skip Archiving checkbox.  If Skip Archiving is checked, no files are archived for any jobs run for this 
transaction. 
 
This setting is recommended when a job routinely transfer a very large number of files or when using the ‘**’ 
wildcard to move entire directory structures and files. 
 
NOTE:  When entire directory structures are moved, the directory structure is not replicated at the archive 
location. 
 
File archiving occurs directly after each file transfer during a job.  When each file transfer is complete with a status 
of either “Success” or “Warning”, files are archived.  For inbound jobs, the destination file is archived.  For 
outbound jobs, the source file is archived. Any files that fail to transfer are not archived and the original file(s) 
remain in the source directory. 
 
For Windows systems, the archive files are located in sub-directories with the same name as the Transaction Name 
for each transaction under C:\ProgramData\Coviant Software\Diplomat-j\archive.  For Linux systems, the archive 
files are located in sub-directories under /opt/coviant/diplomat-j/archive. 
 
Individual archive files have names in the form ‘source_filename.srce.year + month + day.hour + minutes + 
seconds.milliseconds.da’ or ‘destination_filename.dest.year + month + day.hour + minutes + seconds.milliseconds 
da’. For example, an archive of the source version of the file ‘TEST.txt’ created on January 4, 2004 at 3:17:53:769 
p.m. would be named ‘TEST.txt.srce.20040104.151753.769.da’.  
 
At the end of the job, all archive files are zipped into a single zipped archive file, which has a name in the form 
‘DiplomatArchive.TransactionName.year + month + day.hour + minutes + seconds.milliseconds.zip’.  For example, 
a zipped archive file for transaction ‘Test2’ created on January 4, 2004 at 3:17:53:769 p.m. would be named 
‘DiplomatArchive.Test.20040104.151753.769.zip’.   
 
NOTE:  If zipping the files is not successful, the individual archive files are NOT deleted.  
 
NOTE:  Zipped archive files are deleted automatically at after 30 days.  If you want to retain archived files longer 
than 30 days, you must copy them to another location.  Archive file deletion attempts occur each time the 
Diplomat MFT Service is started and daily starting 24 hours thereafter. 
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7.4.8 Troubleshooting 

 
 
Check Turn on Advanced Troubleshooting to capture additional debug and log information and prevent deletion of 
temporary files created during the execution of a transaction.   
 
Advanced Troubleshooting captures debug files, log entries and temporary files in a zip file. For Windows systems, 
the location is C:\ProgramData\Coviant Software\Diplomat-j\troubleshooting.  For Linux systems, the default 
directory is /opt/coviant/diplomat-j/troubleshooting or the corresponding directory for your installation.  
 
NOTE:  Debug files may contain sensitive information such as user names and passwords that are passed in 
plaintext r.   
 
 
Troubleshooting files have names in the form ‘DiplomatTS.TransactionName.year + month + day . hour + minutes + 
seconds.zip’.  For example, a troubleshooting file for transaction ‘Test2’ created on January 4, 2004 at 3:17:53 p.m. 
would be named ‘DiplomatTS.Test2.20040104.151753.zip’.   
 
NOTE:  Turn on Advanced Troubleshooting is unchecked by default.  It should be used ONLY when you need to 
debug a particular transaction, as the zip files in the …\troubleshooting directory are not automatically deleted by 
Diplomat.  You MUST manually delete all troubleshooting files when you are finished using them.   
 
If Turn on Advanced Troubleshooting is checked on any transactions, you will be reminded when you exit the 
Diplomat MFT Client.  You can click through to the transactions from the Troubleshooting On pop-up or check Turn 
off troubleshooting on all transactions, if desired. 
 

 
 

NOTE:  Troubleshooting files only contain temporary files when they are created (e.g., during encryption, 
decryption, signing, or verification). If temporary files are not created and files are transferred using only Local 
Network as the source and destination, no temporary files are captured in the troubleshooting zip file. 
 

7.4.9 Validate/Save/Reset Buttons 

The Validate, Save, and Reset buttons are displayed at the bottom of the active window.  These buttons become 
selectable if changes have been made to any of the data fields, combo boxes, or checkboxes for the transaction.  
The Validate button tests the data displayed in the transaction window to ensure a valid transaction.  If data is 
missing or invalid, a pop-up dialog describes the error.  The Save button saves all changes to the transaction.  The 
Reset button redisplays the previously-saved version of the transaction data.   
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8 Help Menu 

8.1 Diplomat Help 

Diplomat Help provides an online interface to the contents of this Diplomat Managed File Transfer Basic Edition 
User Guide to assist you in using the product.  

8.2 Diplomat Release Notes 

Diplomat Release Notes link to release notes for all Diplomat versions. 

8.3 About Diplomat 

 
 
You will need the information on this screen if you contact Coviant Software Support.  

Licensed To 
The Licensed To panel displays the name of the license owner and the serial number for this copy of Diplomat 
Managed File Transfer.   

Version Number 
The exact version and build numbers of the currently installed Diplomat MFT product.  In addition to the version 
number, Build IDs are displayed in the form ‘Diplomat MFT Client/Diplomat MFT Service’ when you roll the cursor 
over the version number.  You may need to provide the Build ID for the Diplomat MFT Client or Diplomat MFT 
Service to assist Coviant Software Support in diagnosing problems.  

Export Restrictions 
Diplomat Managed File Transfer Basic Edition may not be downloaded or otherwise exported or re-exported to 
any parties in Cuba, Iran, North Korea, Sudan, or Syria. You agree not to directly or indirectly export or re-export 
(including by transmission) this product to any parties in the above countries without first obtaining any required 
export license or governmental approval. 
 
Select Export Restrictions to review detailed export restrictions. 
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9 Support 
Installation and configuration support is provided under warranty for 45 days from initial purchase, as well as 
under annual maintenance agreements.  Email and phone support is available from 9 a.m. ET to 5 p.m. ET 
weekdays.  If you require assistance, contact Coviant Software as follows:  

 

Voice:  781.210.3310 x2 

Fax: 781.210.3313 

Web: www.coviantsoftware.com  

E-mail: support@coviantsoftware.com 

 
 
Diplomat Managed File Transfer products interoperate with other software applications, such as FTP and OpenPGP 
software.  File transfer and encryption failures can occur during a job created by Diplomat Managed File Transfer 
for many reasons, including:  

▪ Inaccurate transaction or setting data 

▪ Connection problems with FTP or local network locations 

▪ Wrong encryption or signature keys on incoming files 

▪ Missing files or keys 

▪ Mismatch between file format and FTP transfer settings 

▪ Compatibility issues with older OpenPGP versions 

▪ Incorrect or incompatible FTP server settings 
 
Typically, these problems are not due to a malfunction of your Diplomat MFT product.  Data to diagnose these 
problems and others are provided in the log file generated when the job or jobs were run.  These types of 
conditions are usually the user’s responsibility.  Please review the diagnostic information provided before 
contacting Coviant Software for support. 
 
If you require support assistance that appears to be due to a malfunction of your Diplomat MFT software, please 
have the following items available before contacting a support representative. 

▪ Diplomat MFT Edition name, version installed, and serial number located in Help > About Diplomat 

▪ Current log file containing entries for the failed job(s) 
 
You may be asked to send some of the above information to the Coviant Software Support representative in order 
to resolve your problem in a timely manner. 
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10 Appendix A:  Configuration Requirements 
Your environment may include not only the computer systems to run Diplomat, but other systems that provide 
functionality that co-exists with or is used by Diplomat, such as FTP servers and OpenPGP software for key 
import/export.  Specific software versions tested for Diplomat Managed File Transfer are shown below. 
 

Supported Software 

Diplomat MFT Service  Windows 71, 8 and 10 (64-bit) 
Windows Server 2008 R21 , 2012 R21 and 20161 (64-bit) 
Red Hat Enterprise Linux v6.3 Intel x86 (64-bit) 

Diplomat MFT Client2  Windows 71, 8 and 10 (64-bit) 
Windows Server 2008 R21, 2012 R21 and 20161 (64-bit) 

FTP Server Any FTP server compliant with FTP (RFC 959), FTPS (RFC 2228 with 
Secure FTP Using TLS), or SFTP (SSH-2; Secure Shell Charter);  
FTP file transfers tested with Windows, UNIX, AS400/Library, and 
AS400/IFS systems; 
SFTP and FTPS tested with Windows systems  

OpenPGP Software3  (Optional) OpenPGP compliant (RFC 2440, RFC 4880) products, such as 
McAfee E-business Server v8.0 – v8.5.2 and PGP Command Line 
v9.0 – v10.2. 

SSH Software (Optional) OpenSSH 
SSH Tectia Server from SSH Communications Security 

 
The hardware configurations shown are based on approximately 50 simultaneous file transfer jobs with associated 
keys.  Your production environment may require less or more memory/disk space depending on the numbers of 
transactions and keys you use. 
 

Minimum Hardware Configurations 

Diplomat MFT Service  
Memory 1 GB  

Disk Space 250 MB 

Diplomat MFT Client  
Memory 512 MB 

Disk Space 170 MB 

 
 
 
1 When running Windows 7, Windows Server 2008 or follow-on products, the Diplomat MFT Service cannot run as a local 
system account.  A logon account with administrator privileges must be specified. For detailed instructions on how to update 
the Diplomat MFT Service, see http://coviantsoftware.com/setting-windows-login.php. 
2 Unix operating systems are not currently supported.  Contact Coviant Software Support for further information. 
3 Diplomat has been tested with the listed software products, but should be compatible with any OpenPGP product compliant 

with RFC 2440 and RFC 4880. 

http://www.ssh.com/products/tectia/server/
http://coviantsoftware.com/setting-windows-login.php
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11 Appendix B:  Advanced Configuration Options 
 
Diplomat MFT Service runs very well with the configuration deployed at installation time for most cases; however, 
in some situations, you will want to control a variety of advanced options that are not available in the Diplomat 
administrative interface.  This appendix documents these advanced options and how to configure them. 

11.1 Cryptography Operations Configuration (Standard and Enterprise Edition ONLY) 

You can configure Diplomat MFT Service to use specific cryptographic operations for SSL/TLS and SSH (SFTP) 
communications by editing a file "diplomat.custom.properties".  The default installation of Diplomat MFT places 
few restrictions on cryptographic operations, in order to ensure robust compatibility with communications with 
partners that rely upon legacy applications.    

It is advisable to review the configuration options and limit the cryptographic operations of the Diplomat MFT 
system to support the highest level of security which your trading partners support, to reduce the risk of data 
breaches.  The Diplomat MFT custom properties supports configuring the Cryptographic options both generally 
across the system, as well as on a per-transaction basis. 

To make cryptographic configuration changes, first locate the file "C:\Program Files\Coviant Sofware\Diplomat-
j\diplomat.custom.properties".  Copy this file into the Diplomat MFT application data area, here:  
"C:\ProgramData\Coviant Software\Diplomat-j".  Note that these values are read into Diplomat MFT once at first 
use after startup, after which they reside in memory.  To make changes to the configuration, edit this file and then 
restart the Diplomat MFT service for the changes to take effect. 

Edit this file in notepad to review the current configuration, including numerous commented lines (which begin 
with the "#" character) that help to explain the available options. 

To make global changes to a given cryptographic operation, change the entry for that protocol.  For example, to 
ensure that only TLS v1.2 is used for SSL communications across the Diplomat MFT system, edit the line as follows: 

ssl.enabledProtocols=TLSv1.2 

Likewise, to ensure that SSH (SFTP) communications are safe for modern deployments, you will want to remove 
known insecure hash algorithms (like MD5 and SHA1) and key exchange algorithms (like diffie-hellman-group1-
sha1).  Therefore, you can edit the entries for SSH (SFTP) to be more secure like this: 

ssh.enabledKEX.sftp=diffie-hellman-group-exchange-sha256 ecdh-sha2-nist384 
ssh.enabledMAC.sftp=aes256-ctr aes192-ctr aes256-cbc 

The entries follow a hierarchical configuration pattern of: 

<ssl or sftp>.<crypto category>.<protocol> 

Where 

• ssl or ssh indicates which of those two cryptographic systems we are configuring 

• crypto category is the part of the cryptographic suite which we are configuring, and is one of 

o For SSL: 

▪ enabledProtocols 
▪ enabledCipherSuites 

o For SSH: 

▪ enabeldKEX 
▪ enabledCipher 
▪ enabledMAC 
▪ enabledCompression 
▪ enabledSignature 

• protocol is the transaction protocol that we are configuring, and is one of: 
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o ftps 
o sftp 
o email 

When configuring these options, you can set global options by specifying only the first two parts of the entry, for 
example "ssl.enabledProtocols" will configure the SSL/TLS protocols to be used by ALL transactions involving 
SSL/TLS, whether it is email or FTP over SSL.   Or, to establish different values for Email than for FTP over SSL, you 
can specify a distinct value for "ssl.email.enabledProtocols". 
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12 Appendix C:  Windows Diplomat MFT Service 
 
Access the Diplomat MFT Service through Services under the Windows Control Panel.   

12.1 Start Diplomat MFT Service 

On the Diplomat MFT Service Properties screen under the Log On tab, confirm that ‘Log on as:’ is set a login 
account with the required privileges.  NOTE:  A login account is REQUIRED when running on Windows 7, Windows 
Server 2008 and follow-on products. 
   
NOTE:  If you use mapped drives or UNC paths when setting up transactions and access to those directories is 
restricted, you must set up a specific login account for the Diplomat MFT Service with the required privileges and 
enter the login account information on the Diplomat MFT Service Properties screen under the Log On tab. 

 

 
 
Once the logon account has been set up, go to the General tab.  The Diplomat MFT Service can be started or 
stopped using the buttons under ‘Service Status’.  
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12.2 Delete Diplomat MFT Service 

When you uninstall the Diplomat MFT Service, the Diplomat MFT Service may be deleted automatically or may be 
marked for deletion and set to disabled.  If the service has been disabled, you must reboot your system to 
complete the deletion. 
 
Check the status of the Diplomat MFT Service through Services under the Windows Control Panel.  If Startup Type 
is set to disabled, you must reboot your system to complete the deletion. 
 
NOTE:  If you are planning to reinstall the Diplomat MFT Service on the same system, you must complete the 
deletion of the service by rebooting before attempting the reinstall.   
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13 Appendix D:  Glossary 

Active Window – Right-hand side of the main screen for Diplomat MFT Client that displays the active key or 
transaction that is being viewed or edited.  Some data is displayed in panels that can be maximized for editing and 
then minimized to save screen space. 

Destination Directory – The directory on an FTP server or local network location where a transaction file is to be 
written.  

Diplomat MFT Client – Desktop application that enables creation and modification of key and transaction 
information, as well as license management and job scheduling.   

Diplomat MFT Service – Run-time engine that executes transactions stored in the Diplomat MFT transaction 
database and interfaces with FTP servers, mail servers, and other systems, as needed.  The Diplomat MFT Service is 
implemented as a Windows service.  After installation, the Windows operating system starts the Diplomat MFT 
Service, which then runs in the background creating jobs for each transaction.  Plus, it creates a log file with system 
messages and archives transaction files, if desired. 

Diplomat MFT Service Login – Windows login identity for the Diplomat Service on the Diplomat MFT site.  Defaults 
to Local Network.   

Diplomat MFT transaction Database – Contains all data needed to create and schedule jobs, including keys, 
transaction, and configuration data.  The transaction database is an embedded SQL database. 

Encryption Subkey – OpenPGP key used to encrypt or decrypt files. 

Firewall – A software program that protects computers on a network from unauthorized Internet access. 

FTP Server – A software program that allows the receipt and pick-up of files, which typically resides outside a 
corporate firewall. 

Inbound Transaction – The process of receiving a file from another organization with optional decryption and 
verification. 

IP Address – The numerical identification of a computer connected to a network.  The IP Address appears with 
periods separating groups of numbers. (i.e. 192.168.0.1).  

Job – A job is a particular execution of a transaction.  For example, if a transaction is scheduled to run once a day, a 
new job will be created and executed once a day.   

License File – Diplomat MFT uses a license file named diplomat.lic to determine the number of keys you can have 
in your Diplomat MFT keystore and the expiration date of your license.   

Log File – File containing chronological system messages generated as a result of Diplomat MFT operation. 

Main Screen – Contains top menu bar, left-hand navigation tree, and active window for Diplomat MFT Client. 

Menu Bar – Bar at the top of the main screen for Diplomat MFT Client that allows access to a variety of functions 
via sub-menus and pop-up dialog boxes. 

Menu Item –Selection on the top menu bar of Diplomat MFT Client.  When a menu item is selected either a sub-
menu or a pop-up dialog box is displayed. 

Merge – Merges data from a Diplomat MFT backup file into the current Diplomat MFT database. 
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Navigation Tree – Left-hand side of the main screen for Diplomat MFT Client that displays folders, sub-folders, and 
objects with status indicators in a tree format for easy navigation  

OpenPGP – Open PGP is one type of public key encryption technology.  It is based on an asymmetric scheme that 
uses a pair of keys: a public key, which encrypts data, and a corresponding private, or secret key for decryption. 
The OpenPGP protocol, created by the Internet Engineering Task Force (IETF), defines standard formats for 
encrypted messages, signatures, private keys, and certificates for exchanging public keys. 

OpenPGP Command Line Tool – OpenPGP products with a command line interface, such as PGP Command Line 
Server and McAfee e-Business Server. 

Open PGP Key Pair – OpenPGP keys are always created as key pairs with a public key and a private key.  The owner 
of a key pair keeps their key pair and gives their trading partner their public key.   

OpenPGP Public Key – The OpenPGP key that is made available to an organization’s trading partners to be used to 
encrypt data that is sent from the trading partner to the organization. 

Outbound Transaction – The process of moving a file from within an organization to a receiving organization with 
optional encryption and signing of the file. 

Panel – Section of active window, usually surrounded by a blue border.  Some larger panels can be maximized for 
editing and then minimized to save screen space. 

Passphrase – Used by OpenPGP algorithms to encrypt your private key.   

PGP – An acronym for Pretty Good Privacy, an encryption application developed by Phil Zimmerman that utilizes 
asymmetrical or public/key pairs to encrypt and decrypt files.  Trademarked by PGP Corporation. 

Pop-up Dialog Box – Window used to collect data for features accessed from the top menu bar in the Diplomat 
MFT Client. 

Restore – Restores a Diplomat MFT database from a backup file. 

Signature Key – The OpenPGP key used to sign a file on encryption and authenticate/verify it on decryption. 

SITE Command – Command issued to FTP server before file transfer begins. 

Source Directory – The directory on an FTP server or local network location where a transaction file is to be picked 
up. 

SSH Key Pair – Key pair created by Diplomat MFT to be used when FTP over SSH is selected for a transaction.  The 
SSH public key is exported and sent to the FTP administrator as part of setting up the FTP login account. 

User Activity – Any action taken when using the Diplomat MFT Client, such as when a user creates, updates, or 
deletes records in the Diplomat MFT transaction database and associated configuration files.  

 


